
About this User’s Manual 

This user’s manual is designed to let you easily find the information you need to 
get the most from your notebook.  

 
• Introduces you to the features of your notebook.  

• Gives you useful details on using your notebook.  

• Tells you how to look after your notebook, whether at home or traveling. 

• Talks about PCI Express Card peripherals and how to use them. 

• Goes into more detail about power management and explains how to 
conserve power while on the move. 

• Introduces you to BIOS, the nervous system of your computer, and how to 
change its fundamental settings. 

 
There is no need to read the manual from the beginning to end. Simply find your 
way to the section that interests you using the table of contents, or browse 
through the manual. 
 
You will come across the following icons in this manual: 
 

 Helpful pointers and tricks to get more from your notebook 

 

 
To help you note and avoid possible damage to your notebook's hardware 
or software, or loss of your work 

 

 Points out possible damage to property, personal injury or death 

 

Information in this document is subject to change without notice. 

© Compal Electronics, Inc. 2007. All rights reserved. 

 

Trademarks used in this document: Microsoft and Windows are registered 
trademarks of Microsoft Corporation. 

Other trademarks and trade names may be used in this document to refer to 
either the entities claiming the marks and names or their products.

 



 

Contents 

Safety Instructions..................................................................................i 
Modem Regulatory Notice.....................................................................v 

Specifications.........................................................................................x 

 Chapter 1 Introducing Your Notebook 

1.1 Front Side ...........................................................................................1-1 
1.1.1 Built-in Camera................................................................................1-2 
1.1.2 Built-in Microphone..........................................................................1-2 
1.1.3 Display.............................................................................................1-2 
1.1.4 Top Panel Buttons and LEDs...........................................................1-2 
1.1.5 Left Panel Buttons ...........................................................................1-3 
1.1.6 Keyboard .........................................................................................1-3 
1.1.7 Finger Printer...................................................................................1-3 
1.1.8 Touch Pad .......................................................................................1-3 
1.1.9 Touch Pad Buttons ..........................................................................1-4 
1.1.10 CIR (Optional) .................................................................................1-4 
1.1.11 Wireless Communication Switch .....................................................1-5 
1.1.12 Device Status Indicators / Power Status ..........................................1-5 
1.2 Right Side ...........................................................................................1-6 
1.2.1 Optical Disc Drive............................................................................1-7 
1.2.2 USB Port .........................................................................................1-7 
1.2.3 RF-in Connector ..............................................................................1-7 
1.2.4 S-Video in Port ................................................................................1-7 
1.2.5 AC Adapter Connector.....................................................................1-8 
1.3 Left Side ..............................................................................................1-9 
1.3.1 VGA Port .........................................................................................1-9 
1.3.2 LAN Jack ....................................................................................... 1-10 
1.3.3 Modem Jack .................................................................................. 1-10 
1.3.4 S-Video out Port ............................................................................ 1-10 
1.3.5 High Power USB Port .................................................................... 1-10 
1.3.6 IEEE 1394 Port.............................................................................. 1-10 
1.3.7 New Card Slot (For PCI Express Card) ......................................... 1-10 
1.3.8 Multiple Digital Media Card Slot..................................................... 1-10 
1.3.9 Audio Ports.................................................................................... 1-11 
1.4 Rear Side........................................................................................... 1-12 

1.5 Bottom Side ...................................................................................... 1-13 
1.5.1 Battery Pack .................................................................................. 1-14 
1.5.2 Battery Release Latch ................................................................... 1-14 

 



 

 Chapter 2 Operating Your Notebook (XP) 
2.1 Turning Your Notebook On and Off ..................................................2-1 
2.1.1 Turning Your Notebook On ..............................................................2-2 
2.1.2 Turning Your Notebook Off ..............................................................2-2 
2.1.3 Logging Off ......................................................................................2-2 
2.1.4 Adding User Accounts .....................................................................2-3 
2.1.5 Standby Mode .................................................................................2-3 
2.2 Tips for Using Windows.....................................................................2-4 
2.2.1 Microsoft Windows XP Help ............................................................2-5 
2.2.2 Windows Desktop............................................................................2-6 
2.2.3 Desktop Cleanup Wizard.................................................................2-7 
2.2.4 Start Button......................................................................................2-7 
2.2.5 Taskbar............................................................................................2-8 
2.2.6 Notification Area (System Tray) .......................................................2-8 
2.2.7 Recycle Bin .....................................................................................2-8 
2.2.8 Control Panel...................................................................................2-9 
2.2.9 My Computer...................................................................................2-9 
2.3 Keyboard and Touch Pad ................................................................ 2-10 
2.3.1 Numeric Keypad ............................................................................ 2-11 
2.3.2 Keyboard Shortcuts ....................................................................... 2-11 
2.3.3 Windows Logo Key Functions ....................................................... 2-12 
2.3.4 StickyKeys ..................................................................................... 2-13 
2.3.5 Touch Pad ..................................................................................... 2-15 
2.3.6 Customizing the Touch Pad........................................................... 2-15 
2.3.7 Finger Printer................................................................................. 2-16 
2.4 Personalizing Your Desktop............................................................ 2-18 
2.4.1 Choosing a Wallpaper ................................................................... 2-19 
2.4.2 Choosing a Screen Saver.............................................................. 2-19 
2.4.3 Choosing a Desktop Theme .......................................................... 2-19 
2.4.4 Creating a Shortcut on the Desktop .............................................. 2-19 
2.5 Display .............................................................................................. 2-20 
2.5.1 Adjusting the Brightness................................................................ 2-21 
2.5.2 Using an External Monitor or Television ........................................ 2-21 
2.5.3 Setting the Display Resolution....................................................... 2-21 
2.6 Networks........................................................................................... 2-22 

2.7 Managing Programs......................................................................... 2-23 
2.7.1 Running Programs......................................................................... 2-24 
2.7.2 Adding Software ............................................................................ 2-24 
2.7.3 Removing Software ....................................................................... 2-25 
2.8 Managing Files ................................................................................. 2-26 
2.8.1 Updating Antivirus Software .......................................................... 2-27 

 



 

2.8.2 Backing Up Files ........................................................................... 2-27 
2.8.3 Finding Files .................................................................................. 2-27 
2.8.4 Copying a File on the Hard Drive .................................................. 2-27 
2.8.5 Copying a File to a Floppy Disk..................................................... 2-28 
2.8.6 Moving Files .................................................................................. 2-28 
2.8.7 Renaming Files ............................................................................. 2-28 
2.8.8 Deleting Files................................................................................. 2-28 
2.8.9 Emptying the Recycle Bin.............................................................. 2-29 
2.8.10 Retrieving Files From the Recycle Bin........................................... 2-29 
2.9 Playing CDs and Movies.................................................................. 2-30 
2.9.1 Inserting Discs............................................................................... 2-31 
2.9.2 Adjusting the Volume..................................................................... 2-31 
2.9.3 Adjusting the Picture...................................................................... 2-31 

 Chapter 3 Operating Your Notebook (Vista) 
3.1 Turning Your Notebook On and Off ..................................................3-1 
3.1.1 Turning Your Notebook On ..............................................................3-2 
3.1.2 Turning Your Notebook Off ..............................................................3-2 
3.1.3 Logging Off ......................................................................................3-2 
3.1.4 Adding User Accounts .....................................................................3-3 
3.1.5 Sleep Mode .....................................................................................3-3 
3.2 Tips for Using Windows.....................................................................3-4 
3.2.1 Microsoft Windows Vista Help .........................................................3-5 
3.2.2 Windows Desktop............................................................................3-6 
3.2.3 Start Button......................................................................................3-7 
3.2.4 Taskbar............................................................................................3-8 
3.2.5 Notification Area (System Tray) .......................................................3-8 
3.2.6 Recycle Bin .....................................................................................3-9 
3.2.7 Control Panel...................................................................................3-9 
3.2.8 Computer....................................................................................... 3-10 
3.3 Keyboard and Touch Pad ................................................................ 3-11 
3.3.1 Numeric Keypad ............................................................................ 3-12 
3.3.2 Keyboard Shortcuts ....................................................................... 3-12 
3.3.3 Windows Logo Key Functions ....................................................... 3-13 
3.3.4 Sticky Keys .................................................................................... 3-14 
3.3.5 Touch Pad ..................................................................................... 3-16 
3.3.6 Customizing the Touch Pad........................................................... 3-16 
3.3.7 Finger Printer................................................................................. 3-17 
3.4 Personalizing Your Desktop............................................................ 3-19 
3.4.1 Choosing a Wallpaper ................................................................... 3-20 
3.4.2 Choosing a Screen Saver.............................................................. 3-20 
3.4.3 Choosing a Desktop Theme .......................................................... 3-20 

 



 

3.4.4 Creating a Shortcut on the Desktop .............................................. 3-20 
3.5 Display .............................................................................................. 3-21 
3.5.1 Adjusting the Brightness................................................................ 3-22 
3.5.2 Using an External Monitor or Television ........................................ 3-22 
3.5.3 Setting the Display Resolution....................................................... 3-22 
3.6 Networks........................................................................................... 3-23 

3.7 Managing Programs......................................................................... 3-24 
3.7.1 Running Programs......................................................................... 3-25 
3.7.2 Adding Software ............................................................................ 3-25 
3.7.3 Removing Software ....................................................................... 3-26 
3.8 Managing Files ................................................................................. 3-27 
3.8.1 Updating Antivirus Software .......................................................... 3-28 
3.8.2 Backing Up Files ........................................................................... 3-28 
3.8.3 Finding Files .................................................................................. 3-28 
3.8.4 Copying a File on the Hard Drive .................................................. 3-28 
3.8.5 Renaming Files ............................................................................. 3-29 
3.8.6 Deleting Files................................................................................. 3-29 
3.8.7 Emptying the Recycle Bin.............................................................. 3-29 
3.8.8 Retrieving Files From the Recycle Bin........................................... 3-30 
3.9 Playing CDs and Movies.................................................................. 3-31 
3.9.1 Inserting Discs............................................................................... 3-32 
3.9.2 Adjusting the Volume..................................................................... 3-32 
3.9.3 Adjusting the Picture...................................................................... 3-32 

 Chapter 4 Caring for Your Notebook  
4.1 Caring for Your Notebook..................................................................4-1 
4.1.1 Cleaning Your Notebook and Keyboard...........................................4-2 
4.1.2 Cleaning the Display........................................................................4-2 
4.1.3 Cleaning the Touch Pad ..................................................................4-2 
4.1.4 Cleaning the CD/DVD Drive ............................................................4-2 
4.1.5 Precautions .....................................................................................4-3 
4.2 Traveling .............................................................................................4-4 
4.2.1 Identifying Your Notebook................................................................4-5 
4.2.2 Packing Your Notebook ...................................................................4-5 
4.2.3 Setting a Password..........................................................................4-5 
4.2.4 Travel Tips .......................................................................................4-6 
4.2.5 If Your Notebook is Lost or Stolen ...................................................4-6 

 Chapter 5 Peripherals 

5.1 PCI Express Cards .............................................................................5-1 
5.1.1 PCI Express Card Types .................................................................5-2 

 



 

5.1.2 Installing a PCI Express Card..........................................................5-2 
5.1.3 Removing a PCI Express Card........................................................5-3 
5.2 Adding and Removing SD/MMC/MS Cards ......................................5-4 

5.3 Memory Modules................................................................................5-5 

Chapter 6 The Power System (XP) 
6.1 Power Management ...........................................................................6-1 
6.1.1 Managing Your Notebook’s Power...................................................6-2 
6.1.2 Power Management Modes.............................................................6-2 
6.1.3 Power Options Properties................................................................6-4 
6.1.4 SpeedStep .......................................................................................6-6 
6.2 Battery.................................................................................................6-7 
6.2.1 Battery Performance........................................................................6-8 
6.2.2 Checking the Battery Charge ..........................................................6-8 
6.2.3 Power Meter ....................................................................................6-8 
6.2.4 Low-Battery Warning .......................................................................6-9 
6.2.5 Charging the Battery........................................................................6-9 
6.2.6 Removing the Battery ......................................................................6-9 
6.2.7 Installing a Battery ......................................................................... 6-10 
6.2.8 Storing a Battery............................................................................ 6-10 
6.2.9 Working With Extra Battery Packs................................................. 6-10 
6.2.10 Maximizing Battery Life ................................................................. 6-10 

 Chapter 7 The Power System (Vista) 
7.1 Power Management ...........................................................................7-1 
7.1.1 Managing Your Notebook’s Power...................................................7-3 
7.1.2 Power Management Modes.............................................................7-3 
7.1.3 Power Options Properties................................................................7-4 
7.1.4 SpeedStep .......................................................................................7-5 
7.2 Battery.................................................................................................7-7 
7.2.1 Battery Performance........................................................................7-8 
7.2.2 Checking the Battery Charge ..........................................................7-8 
7.2.3 Power Meter ....................................................................................7-8 
7.2.4 Low-Battery Warning .......................................................................7-9 
7.2.5 Charging the Battery........................................................................7-9 
7.2.6 Removing the Battery ......................................................................7-9 
7.2.7 Installing a Battery ......................................................................... 7-10 
7.2.8 Storing a Battery............................................................................ 7-10 
7.2.9 Working With Extra Battery Packs................................................. 7-10 
7.2.10 Maximizing Battery Life ................................................................. 7-10 

 



 

Chapter 8 The BIOS Setup Program 

8.1 Introduction ........................................................................................8-1 

8.2 Navigating through the BIOS Setup Program..................................8-2 
8.2.1 Accessing the BIOS Setup Program ...............................................8-3 
8.2.2 Launching Submenus......................................................................8-4 
8.2.3 Saving Changes and Exiting the Setup Program ............................8-4 
8.3 The Main Menu ...................................................................................8-5 

8.4 The Advanced Menu ..........................................................................8-7 

8.5 The Security Menu .............................................................................8-8 

8.6 The TPM State Menu ........................................................................ 8-12 

8.7 The Boot Menu ................................................................................. 8-13 

8.8 The Exit Menu................................................................................... 8-14 
 

 



Safety Instructions 

Safety Instructions 

Use the following safety guidelines to help protect yourself and your computer. 

General Warnings 

• Do not operate your portable computer for an extended period of time with the base 
resting directly on your body. With extended operation, heat can potentially build 
up in the base. Allowing sustained contact with the skin could cause discomfort or, 
eventually, a burn. 

• Do not attempt to service the computer yourself. Always follow installation 
instructions closely. 

• To avoid personal injury from electric shock or fire: 

− Completely power down the computer when replacing memory modules, 
cleaning the computer, its components, or chassis, or performing operations 
requiring similar steps. To do this, first turn the power off at the power switch, 
remove the battery, and then disconnect the AC adapter from the electrical 
outlet or from any other type of external power source, such as an external 
battery. 

− Do not operate the computer near water, for example, near a bathtub, kitchen 
sink or laundry tub, in a wet basement, by a swimming pool, or in the rain.  

− Do not connect or disconnect any cables or perform maintenance or 
reconfiguration of this product during an electrical storm. 

− Avoid using the wired modem or LAN during an electrical storm, as a remote 
risk of electric shock from lightning exists.  

− Do not push objects into the air vents or openings of your computer or 
accessories. Doing so can short out interior components and may cause fire or 
electric shock. 

− When installing memory modules, ground yourself by touching a grounded 
conductive surface, such as a device with a grounded plug. Avoid touching the 
pins and leads on the memory module or internal circuitry of the computer. 

• When setting up the computer for work, place it on a level surface. 

• Handle components with care. Hold a component such as a memory module by its 
edges, not its pins. 

• If the battery pack leaks and the fluid get in your eyes, do not rub them. Instead, 
rinse your eyes with clean running water and immediately seek medical attention. 
Otherwise, eye injury may result. 
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Safety Instructions 

• If acid leaking from the battery pack contacts your skin or clothing, immediately 
wash it away with running water. Otherwise, skin inflammation can occur. 

• Operate the computer at the recommended temperature range of +5oC to +35oC 
(+41oF to +95oF). Store it at a temperature of -20oC to +60oC (+4oF to +140oF). 

• Your computer shipped with plastic dummies installed in the PCMCIA or Express 
slot. Dummies protect unused slots from dust, metal object, or other particles. Save 
the dummy for use when no PCMCIA or Express Card is installed in the slot. 

Power Cord & Adapter Warnings  

• See the installation instructions before connecting to the power supply. 

• Power cord sets for use in other countries must meet the requirements of that 
country. Use the appropriate AC adapter and power cord for your locale.  

• If you use an extension cord with your AC adapter, ensure that the total ampere 
rating of the products plugged into the extension cord does not exceed the ampere 
rating of the extension cable. 

• When using your power cord, make sure to position it around objects so it will not 
be cut or punctured. 

• When you disconnect a cable, pull on its connector on its strain relief loop, not on 
the cable itself. As you pull out the connector, keep it evenly aligned to avoid 
bending any connector pins. Also, before you connect a cable make sure both 
connectors are correctly oriented and aligned. 

• Be sure that nothing rests on your AC adapter’s power cable and that the cable is 
not located where it can be tripped over or stepped on. 

• Use only the AC adapters that are approved for use with this computer. Use of 
another type of adapter may risk fire or explosion. 

• Before you connect the computer to a power source, ensure that the voltage rating 
of the AC adapter matches that of the available power source.  

− 115 V/60 Hz in most of North and South America and some Far Eastern 
countries such as South Korea and Taiwan. 

− 100 V/50 Hz in eastern Japan and 100 V/60Hz in western Japan. 
− 230 V/50 Hz in most of Europe, the Middle East, and the Far East. 
− If you use an extension cable with your AC adapter, ensure that the total 

ampere rating of the products plugged in to the extension cable does not 
exceed the ampere rating of the extension cable. 
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Safety Instructions 

• Place the AC adapter in a ventilated area, such as a desktop or on the floor, when 
you use it to run the computer or to charge the battery. Do not cover the AC adapter 
with papers or other items that will reduce cooling; also, do not use the AC adapter 
while it is inside a carrying case. 

• Disconnect power cords and cables by grasping the connector, not by pulling on 
the cable itself. As you pull out the connector, keep it evenly aligned to avoid 
bending any connector pins. Before you connect a cable, make sure both 
connectors are correctly aligned. 

• To remove power from the computer, turn it off, remove the battery, and disconnect 
the AC adapter from the electrical outlet. 

Battery Pack Warnings 
− Do not carry a battery in your pocket, purse, or other container where metal objec

(such as car keys) could short-circuit the battery terminals. The resulting excessiv
current flow can cause extremely high temperatures and may result in damage from
burns. 

ts 
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− Danger of explosion may occur if battery is incorrectly replaced. Replace only with 
the same or equivalent type battery recommended by the manufacturer. 

− Do not dispose of batteries in a fire. They may explode. Check with local authorities 
for disposal instructions. 

− Do not use or leave the battery pack near a heat source. Heat can melt the insulation 
and damage other safety features, possibly leading it to leak acid, overheat, emit 
smoke, burst and/or ignite. 

− Do not immerse the battery pack in water or allow it to get wet. Its protective feature
can be damaged. Abnormal chemical reactions may occur, possibly leading it 
leak acid, overheat, emit smoke, burst and/or ignite. 

− Do not crush, disassemble, puncture, or incinerate the short external contacts of a 
battery pack. 

− Do not connect the positive (+) and negative (-) terminals with a metal object such as 
wire. Short-circuiting may occur leading the battery pack to leak acid, overheat, emit 
smoke, burst and/or ignite. 

− Do not use an apparently deformed or damaged battery pack, which may leak acid, 
overheat, emit smoke, burst and/or ignite. 

− If the battery pack leaks, gives off a bad odor, generates heat, becomes discolored 
or deformed, or in any way appears abnormal during use, recharging or storage, 
immediately remove it from the computer or charger and stop using it. 
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Safety Instructions 

Battery Pack Disposal 
− Dispose of the lithium ion battery packs at approved disposal sites only. To locate an 

appropriate site, contact the solid waste disposal officials where you live or look for a 
rechargeable battery recycling website that lists disposal locations near you. 

 

− Do not dispose of battery packs in a fire, throw them in a trash receptacle, put them 
in a recycling bin not intended for their disposal, or otherwise discard them in a 
manner that may result in their being hazardous to the environment. 

Internal Modem Warnings  

CAUTION: When using your telephone equipment, basic safety precautions should 
always be followed to reduce the risk of fire, electric shock and injury to persons, 
including the following: 

− The modem cable you connect to your computer should have a minimum wire size 
of 26 AWG (American wire gauge) and an UL-compliant RJ-11 modular plug. 

− Avoid using a telephone (other than a cordless type) during an electrical storm. 
There may be a remote risk of electric shock from lightning. 

− Do not use the telephone to report a gas leak in the vicinity of the leak. 
− Do not plug a modem connector (RJ-11) into a network connection (RJ-45). This 

may damage the connector. 
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Modem Regulatory Notice 

Modem Regulatory Notice 

Federal Communication Commission PART 68 Warning 

This equipment complies with Part 68 of the FCC rules. Located on the bottom side of 
the modem is a label that contains, among other information, the FCC Registration 
Number and Ringer Equipment Number (REN) for this equipment. Upon request, you 
must provide this information to your telephone company. 

If your telephone equipment damages the telephone network, the local telephone 
company may temporarily discontinue your service. If possible they will notify you in 
advance. But, if advance notice is not practical, you will be notified as soon as possible. 
You will also be informed of your right to file a complaint with the FCC. 

Your telephone company may make changes to facilities, equipment, operations, or 
procedures that could affect the proper functioning of your equipment. If they do, you 
will be notified in advance to give you an opportunity to maintain uninterrupted 
telephone service. 

If this equipment should fail to operate properly, disconnect the equipment from the 
phone line to determine if it is causing the problem. If the problem is with the 
equipment, discontinue use and contact your dealer or vendor. 

TBR21 

This equipment has been approved [Council Decision 98/482/EC – “TBR21”] for 
pan-European single terminal connection to the Public Switched Telephone Network 
(PSTN). However, due to differences between the individual PSTNs provided in 
different countries, the approval does not, in itself, give an unconditional assurance of 
successful operation on every PSTN termination point. In the event of problems, you 
should contact your equipment supplier in the first instance. 
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Modem Regulatory Notice 

Important Safety Instructions 

Read these instructions carefully. Save these instructions for future reference. 

1. Follow all warnings and instructions marked on the product. 
2. Unplug this product from the wall outlet before cleaning. Do not use liquid 

cleaners or aerosol cleaners. Use a damp cloth for cleaning. 
3. Do not use this product near water. 
4. Do not place this product on an unstable cart, stand, or table. The product may fall, 

causing serious damage to the product. 
5. Slots and openings in the cabinet and the back or bottom are provided for 

ventilation. To ensure reliable operation of the product and to protect it from 
overheating, do not block or cover these openings. Avoid placing the product on a 
bed, sofa, rug, or similar surface to prevent blocking these openings. This product 
should never be placed near or over a radiator or a heat register, or in an 
enclosure unless proper ventilation is provided. 

6. This product should be operated from the type of power indicated on the marking 
label. If you are not sure of the type of power available, consult your dealer or local 
power company. 

7. Do not allow anything to rest on the power cord. Do not locate this product where 
people will step on the cord. 

8. If an extension cord is used with this product, make sure that the total ampere 
rating of the equipment plugged into the extension cord does not exceed the 
extension cord ampere rating. Also, make sure that the total rating of all products 
plugged into the wall outlet does not exceed the fuse rating. 

9. Never push objects of any kind into this product through cabinet slots as they may 
touch dangerous voltage points or short-out parts that could result in a fire or 
electric shock. Never spill liquid of any kind on the product. 

10. Do not attempt to service this product yourself, as opening or removing covers 
may expose you to dangerous voltages or other risks. Refer all servicing to 
qualified service personnel. 

11. Unplug this product from the wall outlet and refer servicing to qualified service 
personnel under the following conditions: 
a. When the power cord or plug is damaged or frayed. 
b. If liquid is spilled into the product. 
c. If the product was exposed to rain or water. 
d. If the product does not operate normally when the operating instructions are 

followed, adjust only those controls that are covered by the operating 
instructions. Improper adjustment of other controls may result in damage and 
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will often require extensive work by a qualified technician to restore the 
product to normal condition. 

e. If the product has been dropped or the cabinet has been damaged. 
f. If the product exhibits a distinct change in performance, indicating a need for 

service. 

EMC Regulatory Information 

This product is designed and tested to comply with the following related EMC 
(Electromagnetic compatibility) standards. 

FCC Notice 

“Declaration of Conformity Information” 

This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference in a residential installation.  

This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference 
to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to 
radio or television reception, which can be determined by turning the equipment off 
and on, the user is encouraged to try to correct the interference by one of following 
measures: 

• Reorient or relocate the receiving antenna. 

• Increase the separation between the equipment and receiver. 

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions:  

(1)  This device may not cause harmful interference. 
(2)  This device must accept any interference received, including interference that 

may cause undesired operation. 
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Canadian Notice (Canada Only) 

 

 

Norwegian Notice (Norway Only) 

For Class I equipment: In Norway, intended to be connected to CABLE 
DISTRIBUTION SYSTEMS, the screen of a coax cable is required to be galvanic 
isolated from the protective earth. The Norwegian text is that ”Må kun tilkoples 
kabel-TV nett via galvanisk isolator.” 

CE Notice (European Union) 

EU Declaration of Conformity 

 

 

BSMI Notice (Taiwan Only) 

Most Compal computer products are classified by the Bureau of Standards, 
Meteorology and Inspection (BSMI) as Class B information technology equipment 
(ITE). 

 

This (marked on the product) indicates the product complies with the 
BSMI standard. 

viii 



Modem Regulatory Notice 

BSMI 通告 (僅限於台灣地區)  

如果您在電腦的底部、側面或背面板上找到一個  標誌，則適用於以下部份

的相關規定： 

 

Macrovision License of Notice 

This product incorporates copyright protection technology that is protected by 
methods and claims of certain U.S. patents and other intellectual rights owned by 
Macrovision Corporation, and other rights owners. Use of this copyright protection 
technology must be authorized by Macrovision Corporation and is intended for home 
and other limited viewing uses only unless authorized by Macrovision Corporation. 
Reverse engineering or disassembly is prohibited. 
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Specifications 

Specifications 

CPU 
• Intel Mobile Penryn & Merom & Merom ICPM, FCPGA, Socket P, 3M 4M  6M 

L2, FSB 800/667MHz 

• Micro FC-PGA package CPU 

Chipset 
• Intel PM965  (667/800 MHz FSB supported) 

• ENE KB925 for Keyboard Controller, Battery management Unit, and RTC  

• ICH8-M 

• Ricoh R5C833 for  3 in 1 controller and IEEE1394 controller 

• External VGA card for PM965 

• Realtek ALC268 for High Definition Audio Codec with Dolby 

• Broadcom BCM5787KMLG for Giga LAN 

Memory 
• On board with two 200-pin +1.8V DDRII SO-DIMM connector, supporting,     

DDR II 533/667 SDRAM memory interface design , 0MB DDR RAM on 
board ,Two DDR SODIMM slots  Maximum memory: 2GB per slot. 4GB total 

• 4MB L2 Cache on Merom CPU, 3MB or 6MB L2 Cache on Penryn CPU. 

• Support 128MB/256MB VGA memory for MXM II 

• Adjustable128MB UMA VGA memory share from North Bridge 

• VRAM:GDDR2,up to 256MB 

Display 
• Supports 15.4” WXGA (1280 x 800) TFT color LCD 

• Supports 15.4” WXGA+ (1440 x 900) TFT color LCD 

• Supports 15.4” WSXGA+ (1680 x 1050) TFT color LCD 

Keyboard 
•      ENE 925Q K/B controller 

•      86-US/87-UK/88-JA Key; 12 function keys; 4 cursor keys 

•      Windows key; Application keys, 19.05mm pitch, 2.5mm stroke, H=5.1mm 

Hard Disk Drive (HDD) 
• SATA 
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Specifications 

 
• 9.5mm, 2.5” HDD Support with 80GB/120GB/160GB/200GB/250GB 

• PCI Bus Master Enhanced IDE 

• 5400 RPM and 7200 RPM 

Optical Disc Drive (ODD) 
• 5.25” 12.7mm height 24X DVD/CD-RW Combo Drive 

• 5.25” 12.7mm height 8XDVD-Super Multi Drive 

Pointing Device 
• Touch Pad  

• 4-way Scroll button 

I/O Ports 
• One 15 pins CRT port 

• One S-video port 7-pin 

• One RF-In connector 

• One AV-In connector 

• One MIC In 

• Headphone-Out 

• 90W DC-in jack for AC Adapter 

• One Single-Wide New Card slot, 54mm type 

• Four External USB 2.0 jacks 

• One RJ-11 jack for Modem 

• One RJ-45 jack for LAN  

• One IEEE 1394(4 pin) 

• CIR 

• 3 in 1 connector 

WLAN 
• PCI Express base specification compliant 

• 802.11 a/b/g/n: Intel WLAN card 

Modem 
• Internal Modem with MDC solution (MDC1.5) (optional) 
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Specifications 

Bluetooth 
• Foxconn Bluetooth V2.0+EDR (Broadcom chipset) 

Mini Card Organization 
• One Mini card slot for WLAN 

• One Mini card for TV-Tuner or 3G module 

• One Mini card for Robson 

NEWCARD 
• One Single-Wide New Card socket 

• Supports both PCI-Express Card and USB2.0 Card 

Excellent Power Management Function 
• Suspend to RAM or Suspend to Disk mode, by time out or by hot key  

• HDD Local Standby mode by time out 

• LCD Local Standby mode by time out 

• Low battery alarm (beep) 

• Auto-backlight off when LCD cover closed 

• Full ACPI 1.0B supported 

• LCD Auto-DIM mode by time out 

Easy Buttons 
• Power button 

• Empowering Button 

• Internet Button 

• E-mail button 

• Wireless On/Off Button 

• Bluetooth On/Off Button 

• Arcade button 

AC Adapter 
• Universal AC adapter. 100-240V AC, 50-60Hz 

• 90W with 19V DC output 

• 3 pin type for AC-in 

Memory Card & SO-DOMM Socket 
• 3-in-1 Card Reader (MS, SD, MMC) 

• Push-push type, with dummy card 
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• Ricoh R5C833 Card reader controller 

Options 
• 256MB/512MB/1024MB/2048MB SO-DIMM modules 

• MINI Card Wireless LAN module 

• MINI Card  TV-Tuner module 

• MDC V1.5 Modem 

• Bluetooth module 

• Dual-Band builds in Antenna for Wireless LAN Communication 

xiii 
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Introducing Your Notebook 

 



1 Introducing Your Notebook 

1.1 Front Side 
The following picture shows the front side of the notebook. 

 

1 Built-in Camera 9 Finger Printer 

2 Built-in Microphone 10 Touch Pad 

3 Display 11 Touch Pad Buttons  

4 Power Button 12 Consumer Infrared Receiver 
(optional)

5 Easy Buttons 13 Wireless Communication Switch 

6 Status LEDs 14 Device Status Indicators/Power 
Status

7 Power USB / Q-Charging Buttons 15 Internal Speakers 

8 Keyboard   
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1 Introducing Your Notebook 

 

1.1.1 Built-in Camera 

The built-in camera supports a 2.0 mega pixel CMOS web camera. 

1.1.2 Built-in Microphone 

The built-in microphone allows you to communicate without connecting an external 
microphone. 

1.1.3 Display 

Your display is either a 15.4” COLOR TFT WXGA, WXGA+, or WSXGA+ LCD. 

1.1.4 Top Panel Buttons and LEDs 

 

- Power Button: 

 Press to turn your notebook on. For more on power settings, see 6.1 Power 
Management (XP) or 7.1 Power Management (Vista). 

 
Windows XP or Vista, which comes preinstalled, goes into the shutdown sequence 
automatically if you press the power button while on. 

In Windows XP, you can configure this in Control Panel > Power Options > 
Advanced. 

In Windows Vista, you can configure this in Control Panel > System and 
Maintenance or Hardware and Sound > Power Options > Change plan settings > 
Change advanced power settings. 

- Easy Buttons: 
The notebook offers these buttons for quick launch programs and functions. 
 

 Internet access button 

 Email button 

Wow Video 
Wow Audio Wow Video/Audio 

 Mute button 
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1 Introducing Your Notebook 

- Keyboard Indicators: 

 HDD access indicator 

 Num Lock On/Off indicator 

 Caps Lock On/Off indicator 

 Scroll Lock On/Off indicator 

1.1.5 Left Panel Buttons 

USB Buttons 
 

 
Q-Charging button 

 
Power USB button 

1.1.6 Keyboard 

The keyboard includes a numeric keypad and the Microsoft® Windows® logo key.  

See 2.3 Keyboard and Touch Pad (XP) or 3.3 Keyboard and Touch Pad (Vista) for details 
on using keyboard shortcuts. 

1.1.7 Finger Printer 

The finger printer allows you to enroll the computer with registered fingerprint. This 
recognition device helps prevent unauthorized access by others. For more information, see 
2.3.7 Finger Printer (XP) or 3.3.7 Finger Printer (Vista). 

   

1.1.8 Touch Pad 
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1 Introducing Your Notebook 

 
The touch pad works like a desktop mouse. For more information, see 2.3 Keyboard and 
Touch Pad (XP) or 3.3 Keyboard and Touch Pad (Vista). 

 

1.1.9 Touch Pad Buttons 

The left and right touch pad buttons perform the same functions as the left/right buttons of a 
standard mouse. 

 

1.1.10 CIR (Optional) 

The CIR is an infrared receiver, which allows your notebook to work with a remote control 
to create a TV/ Multimedia environment (Power Cinema). Make sure you position the 
remote accurately so that the CIR can receive the signal. 
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1 Introducing Your Notebook 

1.1.11 Wireless Communication Switch 

Turns the wireless communication function on or off. The wireless communication LED on 
the front panel lights when the function is activated. 

1.1.12 Device Status Indicators / Power Status 

The LEDs on the front of notebook indicate the device and power status. 

 

1 Power On (Blue) 

2 Battery Charge (Blue/Amber) 

3 Bluetooth (Amber)/Wireless (Blue) 

4 Wireless Communication Switch 

5 Consumer Infrared (CIR) (optional) 
 

The flashing Power On LED indicates the notebook is in standby mode. 

For detailed battery status, see 6.2 Battery (XP) or 7.3 Battery (Vista). 
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1 Introducing Your Notebook 

 
1.2 Right Side 
The following picture shows the right side of the notebook. 

 

 

1 Optical Disc Drive 

2 USB Ports 

3 AC Adapter Connector 
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1 Introducing Your Notebook 

1.2.1 Optical Disc Drive 

The optical disc drive provides a means for you to import/export data into/from your 
computer. Depending on the configuration of your computer, you may either be able to 
record or play CDs/DVDs. 

1.2.2 USB Port 

 
Use this port to connect a USB device, such as a mouse, external keyboard, or 
printer to the computer. 

 

 
USB is a peripheral expansion standard that supports data-transfer rates up to 480 
Mbps. USB peripherals have a single standard for cables and connectors. You can 
install and remove USB devices while the computer is on. This is called "hot 
swapping". 

1.2.3 RF-in Connector 

 
Use this port to connect an antenna set. See 1.1.3 Display. 

1.2.4 S-Video in Port 

 
The S-Video in port allows you to connect a video output device, like a VCR, 
TV, camcorder or device which has S-video port, to the notebook. 
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1 Introducing Your Notebook 

 

1.2.5 AC Adapter Connector 

 
Use this connector to attach the AC adapter to your notebook. You can connect 
an AC adapter when your notebook is switched on or off. 

 

 
 

 
While the AC adapter works with electrical outlets worldwide, power connectors 
and power strips vary by country. Ensure you use a compatible cable or correctly 
connect the cable to the power strip or electrical outlet. Failure to do so may cause 
fire or damage to equipment. 
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1 Introducing Your Notebook 

1.3 Left Side 
The following picture shows the left side of the notebook. 

 

1 VGA Port 

2 LAN Jack (Green/Amber) 

3 Modem Jack 

4 S-Video out Port 

5 High Power USB Ports 

6 IEEE 1394 Port 

7 New Card Slot 

8 Multiple Digital Media Slot 

9 Microphone Jack 

10 Headphone Jack 

1.3.1 VGA Port 

 
Use this port to connect an external monitor to your computer. See 1.1.3 
Display. 
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1 Introducing Your Notebook 

 
1.3.2 LAN Jack 

 

The RJ-45 network jack allows you to connect your notebook to a local area 
network (LAN).  

 

 
Be careful not to plug the telephone line into the slightly larger network connector.

1.3.3 Modem Jack 

 

The modem jack allows you to connect the notebook to a telephone line with a 
standard RJ-11 connector. 

1.3.4 S-Video out Port 

 
The S-Video out port allows you to connect an external display device, like a 
TV set or device which has S-video port, to the notebook. 

1.3.5 High Power USB Port 

 

High-power USB ports can provide power for devices that draw more than 
100mA from the bus line, such as cameras and external hard disks. 

1.3.6 IEEE 1394 Port 

 

The IEEE 1394 port allows you to connect devices that utilize IEEE 1394 
technology to your computer. This technology is widely used in consumer 
products such as digital cameras. 

1.3.7 New Card Slot (For PCI Express Card) 

Supports 54mm type PCI Express Card. For more information, see 5.1 PCI Express Cards.  

1.3.8 Multiple Digital Media Card Slot 

Supports one SD/MMC/MS card, which is used in digital still camera and various forms of 
portable information equipment. 
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1.3.9 Audio Ports 

You can connect a headphone or an external speaker to the  port and a microphone to the 

 port. The built-in speakers are disabled when a device is connected to the  port. 
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1 Introducing Your Notebook 

 
1.4 Rear Side 
The following picture shows the rear side of the notebook. 
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1 Introducing Your Notebook 

1.5 Bottom Side 
The following picture shows the bottom side of the notebook. 

 

 

 

1 Battery Pack 

2 Battery Release Latch 

3 HDD Cover 

4 Battery Lock Switch 

5 Thermal Cover 

6 Memory Module Cover 
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1.5.1 Battery Pack 

With a charged battery pack installed, you can use your notebook without connecting it to 
an electrical outlet. For more details, see 6.2 Battery (XP) or 7.3 Battery (Vista). 

 
To remove the Battery Pack: 
1. Move the Battery Lock Switch to the right (Unlock position). 

2. Slide the Battery Release Latch to the left and gently pry the Battery Pack from the 
computer chassis. 

1.5.2 Battery Release Latch 

The Battery Release Latch secures the battery pack. To release, slide the latch and then 
remove the battery pack from the bay. 
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2 Operating Your Notebook (XP) 

2.1 Turning Your Notebook On and Off 

 Turning Your Notebook On 

 Turning Your Notebook Off 

 Logging Off  

 Adding User Accounts  

 Standby Mode 
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2 Operating Your Notebook (XP) 

2.1.1 Turning Your Notebook On 

 
You can configure the computer to start from a specific drive, such as a CD-ROM, 
an external floppy disk, or even an external device. See 8.7 The Boot Menu. 

 

Press the power button  to turn on your notebook. 
 

 
Do not turn off the computer until the operating system has loaded completely. 
Turning the computer off during its initial startup will result in an error the next 
time you start your notebook. 

2.1.2 Turning Your Notebook Off  

 
If your notebook uses Microsoft Windows XP Professional operating system, the 
security and networking features are not available in Windows XP Home Edition. 
You will see different options in some windows, related to security and networking.

 

Save and close any open files, exit any open programs.  

Click Start > Turn Off Computer > Turn Off. 

Your notebook will automatically turn off after the shutdown process is finished. 
 

 
You can configure Windows XP to shut down or go into sleep mode by pressing the 
power button. Open the Control Panel > Power Options > Advanced dialog box to 
do this. 

2.1.3 Logging Off 

With Microsoft Windows XP, multiple users can access a single computer with their own, 
personal settings. Using their own password, each user logs on to the computer, meaning 
other users cannot access their settings or files. To log off: 

Save and close any open files, exit any open programs, click Start > Log Off > Log Off. 

To switch users, click Start > Log Off > Switch User. 

Using Fast User Switching, programs executed by previous users remain running in the 
background. This means a possible slower computer response. It may also stop multimedia 
programs, including games and DVD software, from running. 
 

 
Fast User Switching does not work if your notebook is running Windows XP 
Professional and is a member of a computer domain or if the notebook has less than 
128 MB of memory. 

You can set up Fast User Switching in the Control Panel dialog box, under User 
Accounts: Change the way users log on or off. 
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2 Operating Your Notebook (XP) 

2.1.4 Adding User Accounts 

 
Different account options are available when a computer is running Windows XP 
Professional operating system and is connected to a domain. 

 

With Windows XP installed, the system administrator or a user with administrator rights can 
create additional user accounts: 

1. Click Start > Control Panel > User Accounts. 

2. Under Pick a task, click Create a new account. 

3. Under Name the new account, enter the name of the new user. Click Next. 

4. Under Pick an account type, choose one of the following options: 

• Computer administrator: User can change all computer settings. 

• Standard (Windows XP Professional only): User can install some programs 
and hardware. 

• Limited: User can only change his own personal settings, such as the password. 
User is not able to install programs or use the Internet. 

5. Click Create Account. 

2.1.5 Standby Mode 

To find out how to conserve power using the Standby Mode, see 6.1 Power Management.  
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2.2 Tips for Using Windows 

 Microsoft Windows XP Help 

 Windows Desktop 

 Desktop Cleanup Wizard 

 Start Button 

 Taskbar 

 Notification Area (System Tray) 

 Recycle Bin 

 Control Panel 

 My Computer 
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2 Operating Your Notebook (XP) 

2.2.1 Microsoft Windows XP Help 

For Microsoft Windows XP help, click the Start menu then click the Help and Support 
icon. The Help and Support Center dialog box opens. 
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2 Operating Your Notebook (XP) 

2.2.2 Windows Desktop 

 
Depending on your notebook setup and software, your desktop may have different or 
additional shortcuts. See 2.4 Personalizing Your Desktop for more information. 
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2 Operating Your Notebook (XP) 

2.2.3 Desktop Cleanup Wizard 

The Desktop Cleanup Wizard moves icons for programs not frequently used to a folder 7 
days after you first start your notebook and every 60 days after that.  

The Start menu's appearance changes as program icons are moved. To turn off the Desktop 
Cleanup Wizard: 

Right-click an empty spot on your desktop > Properties > Desktop > Customize Desktop 
> click Run Desktop Cleanup Wizard every 60 days to remove the check mark > OK. 

The Desktop Cleanup Wizard can be run any time by clicking Clean Desktop Now under 
Desktop cleanup. 

2.2.4 Start Button 

The Start button allows easy access to your notebook's programs. 

 
The Start menu is designed to show the programs you use most frequently. To always keep 
an item on the Start menu, no matter how often it's used, right-click the item and click Pin 
to Start menu. 

Log Off allows the current user to log off so a new user can log on to the notebook using his 
personal settings. 

Turn Off Computer provides options for turning off, restarting, and placing your notebook 
in power saving modes. If your notebook is running Windows XP Professional and is 
connected to a domain, different options appear in the Shut Down window. 

2-7 



2 Operating Your Notebook (XP) 

2.2.5 Taskbar 

The Start button is on the left and the notification area on the right. Each time you open a 
program, a button for it appears on the taskbar. To toggle taskbar buttons, click the relevant 
button. Windows XP groups multiple instances of the same program on a single taskbar 
button if more space is needed.  

Toolbars can be added to or removed from the taskbar: 

Right-click an empty spot on the taskbar, and select Toolbars > choose the toolbar you 
want to add. 

2.2.6 Notification Area (System Tray) 

The icons in this area allow quick access to programs and computer functions, including the 
clock and printer status. Windows XP hides icons that are not used frequently. Click  to 
see hidden icons. 

To prevent Windows XP from hiding icons: 

Right-click an empty spot on the Taskbar > Properties > ensure that Hide inactive icons is 
not checked. 

 
 

2.2.7 Recycle Bin 

When you delete a file, it is moved to the Recycle Bin. Files can be restored from the 
Recycle Bin. 

Emptying the Recycle Bin deletes files permanently. 
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2 Operating Your Notebook (XP) 

2.2.8 Control Panel 

In the Control Panel, you can change how Windows looks and works. 

Click the Start button and then Control Panel. 

There are two interfaces - you can choose either Classic View or Category View. You can 
switch interfaces in the upper left hand of the Control Panel window. 

Under Pick a category, choose the category of the task you wish to complete, and then 
choose the task in the next window.  

 
2.2.9 My Computer  

My Computer allows you to see the disk drives and other external devices connected to 
your notebook. The My Computer icon appears on your Desktop. To see the contents of a 
drive or folder, open My Computer then double-click the icon for the drive or folder you 
want to view (for example, drive C). 
 

 
You can also use Windows Explorer to see the contents of your notebook and find 
files. To open Windows Explorer, right-click the Start button and click Explore to 
find the drive or folder that you want to view. To find out more about My Computer
and Windows Explorer, see Help and Support Center. 
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2 Operating Your Notebook (XP) 

2.3 Keyboard and Touch Pad 

 Numeric Keypad 

 Keyboard Shortcuts 

 Windows Logo Key Functions 

 StickyKeys 

 Touch Pad 

 Customizing the Touch Pad 

 Finger Printer 
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2 Operating Your Notebook (XP) 

2.3.1 Numeric Keypad 

Keypad numbers and symbols are marked in blue on the lower right edge of the keypad 
keys.  

To enable the numeric keypad, press . 

The  indicator will light when the numeric lock is on. 

To disable the numeric keypad, press  again. 

To use the primary function of a dual-function key when the numeric keypad is enabled,  

press  and the desired key.  

2.3.2 Keyboard Shortcuts 

 
Sleep 

 

Wireless/Bluetooth On/Off 

To enable this function, you need to install Wireless Select Switch.

 

Switches Display Mode (LCD > CRT > TV > LCD + CRT 
Simultaneous > LCD+TV Simultaneous). Switches the video image 
to the next display or both displays simultaneously. 

 
Brightness Down 

 
Brightness Up 

 
Mute 

 
Audio Volume Down 

 
Audio Volume Up 

 
Play/Pause 
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2 Operating Your Notebook (XP) 

 
Stop 

 
Fast Rewind 

 
Fast Forward 

  Number Lock 

  
Scroll Lock 

 
Caps Lock 

2.3.3 Windows Logo Key Functions 

  
Opens Windows Explorer 

  
Opens the Run dialog box 

  
Opens the Search Results dialog box 

  

Opens the Search Results - Computers dialog box (when 
your notebook is connected to a network) 

  
Opens the System Properties dialog box 

 
To adjust keyboard operation, including character repeat rate, in the Control Panel click 
Printers and Other Hardware > Keyboard. 
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2.3.4 StickyKeys 

The StickyKeys function lets you use the SHIFT, CTRL, ALT, FN keys or the Windows 
logo key (referred to as modifier keys) in conjunction with other keys by pressing one key at 
a time instead of simultaneously. 

To activate StickyKeys mode, press the Shift key five times and then click OK. 

 
Alternatively, you can click on Start > Control Panel > Accessibility Options and check 
Use StickyKeys before clicking OK. 
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To further customize StickyKeys, click Settings in either of the above dialogue boxes. The 
following dialogue box will appear. 

 
Click Use shortcut to enable the listed shortcut to activate StickyKeys mode. 

By checking Press modifier key twice to lock, pressing the SHIFT, CTRL, ALT, FN or 
the Windows logo key twice will 'lock' the key until it is pressed again. This allows you to 
perform multiple commands with these keys in succession without having to press the 
modifier key again each time. 

Check Turn StickyKeys off if two keys are pressed at once to have StickyKeys 
automatically disable whenever any two keys are pressed simultaneously. 

If Make sounds when modifier key is pressed is checked, a tone will be heard each time a 
modifier key is pressed. Different tones are heard when activating and deactivating modifier 
keys. 

Check Show StickyKeys status on screen to display the StickyKeys icon in your toolbar 
whenever the StickyKeys mode is activated. The icon will change to indicate which 
modifier key, if any, is currently active. 

Click on OK to confirm your changes, or Cancel to exit the dialogue box without making 
any changes. 
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2.3.5 Touch Pad 

The Touch Pad responds to the movements and pressure of your finger, allowing you to 
move the cursor around the screen, in the same way you would with a mouse. 

 
Place your fingers on the keyboard in the normal typing position. 

You can use the Touch Pad by moving either your right or left thumb off the space bar and 
on to the Touch Pad. 

Gently move your thumb across the Touch Pad in the direction you want the cursor to move. 

The Touch Pad buttons have the same function as mouse buttons. Clicking these buttons 
makes selections, drags objects, or performs a variety of other functions depending on the 
software. To select an object, first move the pointer over the object you want to select, and 
then press the left button one time and release it. The functionality of these buttons depends 
on your software. 

Double-clicking is a common technique for selecting objects or launching programs. 

You may also select object or execute applications from icons by double tapping. This is 
similar to double-clicking; instead of pressing the Touch Pad buttons, you tap the Touch Pad 
itself. 

2.3.6 Customizing the Touch Pad 

To adjust Touch Pad settings, use the Mouse Properties window, which you can open by 
clicking Control Panel > Printers and Other Hardware > Mouse. 

Select the desired settings and click Apply. 

Click OK to save the settings and close the window. 
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2.3.7 Finger Printer 

The finger printer lets you log on to your computer instead of inputting passwords from the 
keyboard. 

To raise the recognition success rate, the following illustrations show the correct way to 
swipe your finger over the finger printer. 

 
Align your fingertip with the finger printer as shown in the drawing and swipe. 

 

To reduce the damage to the finger printer and fingerprint recognition problems, follow 
these guidelines when using the finger printer. 

• Do not scratch or poke the finger printer with your nails or any hard or sharp 
objects. 

• Do not press the finger printer strongly. 

• Do not touch the finger printer with a wet finger or any wet objects. Keep finger 
printer surface dry and free of water vapor. 

• Do not touch the finger printer with a soiled finger. Minute foreign particles on a 
soiled or dirty finger may scratch the finger printer. 

• Do not paste stickers or write on the finger printer. 

• Do not touch the sensor with a finger or any object with built-up static 
electricity. 
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2.3.7.1 Delete the Finger Printer Data 
Saved fingerprint data is stored in the non-volatile memory inside the finger printer. 
Fingerprint data are recommended to delete before you hand over the computer the others, 
or dispose of it. 

To delete the fingerprint data, do the following: 

1. Click Start > All Programs > Protector Suite QL > Control. 

2. The Protector Suite Software screen is displayed. 

3. Click Fingerprints > Delete. 

4. Click Settings > Fingerprint Storage Inspector. 

5. The Fingerprint Storage Inspector screen is displayed. If other fingerprint data is still 
displayed on the list. Select all fingerprint data and click remove. 

6. Check whether all fingerprint data was deleted on the Fingerprint Storage Inspector 
screen. 
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2.4 Personalizing Your Desktop 

 Choosing a Wallpaper 

 Choosing a Screen Saver 

 Choosing a Desktop Theme 

 Creating a Shortcut on the Desktop 
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2.4.1 Choosing a Wallpaper 

To make your notebook reflect your style, you can set background colors, patterns, and the 
wallpaper on the desktop. 

Control Panel > Appearance and Themes > Pick a task > Change the desktop 
background. 

The Display Properties window offers a choice of wallpapers. Choose the name of the 
wallpaper you want to display, or choose (None) if you prefer not to use a wallpaper image. 

You can also choose your own images by choosing Browse, and specifying images in a 
directory. 

The Position pull-down menu lets you either Tile your selected image, Center (places one 
copy of the image in the center of the screen) or Stretch (enlarges it to fit the screen). 

To accept the settings, click OK and close the Display Properties window. 

2.4.2 Choosing a Screen Saver 

Control Panel > Appearance and Themes > Pick a task > Choose a screen saver. 

Select a screen saver from the Screen saver pull-down menu, or choose (None) if you prefer 
not to activate a screen saver. 

You can customize your screen saver by choosing Settings. To check your selections, click 
Preview. 

To accept the settings, click OK and close the Display Properties window. 

2.4.3 Choosing a Desktop Theme 

Desktop themes change the appearance of your desktop and add sound effects: 

Control Panel > Appearance and Themes > Pick a task > Change the computer's 
theme. 

Select a theme from the Theme pull-down menu in the Display Properties Window, and 
then click OK. 

2.4.4 Creating a Shortcut on the Desktop 

A shortcut is an icon that is placed on the desktop let you quickly access programs, files, 
folders, and drivers. To create a shortcut: 

Open My Computer or Windows Explorer, and highlight the file or program for which 
you want to create the shortcut. 

Click and hold down the right Touch Pad button, drag the highlighted item to the Windows 
desktop, and then release the right Touch Pad button to display a pop-up menu. 

Click Create Shortcuts Here. 

An icon appears on your desktop - double-click to activate the shortcut. 
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2.5 Display 

 Adjusting the Brightness 

 Using an External Monitor or Television 

 Setting the Display Resolution 
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2.5.1 Adjusting the Brightness 

To conserve power when running your notebook from the battery, set the brightness to the 
lowest comfortable setting using the keyboard shortcuts. 

 

 
Brightness Down 

 
Brightness Up 

2.5.2 Using an External Monitor or Television 

When you start your notebook with an external display device such as an external monitor 
or television attached and turned on, the image may appear on either the display or the 
external device. 

Alternatively, you can press  to switch the video image to the display only, the 
display and the external device simultaneously, or the external device only. 

2.5.3 Setting the Display Resolution 

To view a program at a specific resolution, both the video controller and the display must 
support the program and the necessary video drivers must be installed. 

Before changing any of the original display settings, note the original settings for future 
reference. 

Click Start > Control Panel > Pick a category > Appearance and Themes. 

Under Pick a task..., click Change the screen resolution, or under or pick a Control 
Panel icon, click Display and select Settings tab. 

You can try different settings for Screen resolution and Color quality. 

If you choose a resolution or color palette that is higher than the display supports, the 
settings will automatically adjust to the closest possible setting. 

2-21 



2 Operating Your Notebook (XP) 

2.6 Networks 
To access a network: 

At the office, you can access a network via the built-in PCI-E LAN.  

For specific information about connecting to the LAN or WAN, consult your systems 
administrator. 

If you are working at home or while traveling, you need a dial-up connection. Ask your 
system administrator for the telephone number of the network. 

To set up the connection, go to Start > Control Panel > Network and Internet 
Connections (in Classic Interface, Network Connections).  

Enter the details for your connection and click OK.  
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2.7 Managing Programs 

 Running Programs 

 Adding Software 

 Removing Software 
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2.7.1 Running Programs 

Programs are any software that process data - like a word processing program or an email 
program. They require an operating system - like Windows XP - to run on. 

To run a program, click Start > Programs. 

Click the program you want to run. 

On the right side of the title bar in the window of any open program,  

there are three icons:  

 

 minimizes the program window. That is, it is removed from the screen, but is still 
running. It will appear as a tab on your bottom taskbar. To restore the program window, 
simply click the tab. 

 maximizes the window to fill your entire screen. When the window is maximized, the 

button switches to , which will reduce the size of the window when clicked. 

 closes the program or document. 

2.7.2 Adding Software 

To check what software is already installed on your computer, click Start > All Programs. 
If a program is listed in the All Programs menu or the Start menu, the software is already 
installed. 

Before installing software, check the software's technical requirements to ensure that it is 
compatible with your notebook and that there is enough memory and hard drive space for 
installation and operation. 

Temporarily disable your notebook's antivirus software before installing software. See the 
documentation that came with the antivirus software for detailed procedure. 
 

 
Be sure to enable your antivirus software once you have installed any new software.

 

Insert the software installation CD into the CD drive and follow the instructions that came 
with the software to help you respond to the prompts on the screen. 

If the software installation CD does not automatically run, click Start > Run. In the 
dialogue box, type x:\setup.exe (where x is the letter of your CD drive [usually D or E]). 
Then click OK and follow the prompts on your screen. 
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2.7.3 Removing Software 

 
Once you've begun removing software, do not interrupt the process. To do so may 
result in data loss and corruption of your operating system. 

 

Start > Control Panel > Add or Remove Programs > Change or Remove Programs. 

Select the program that you want to remove and click the Change/Remove button. 
Instructions for removing programs will appear on the screen. 
 

 
Some programs may not be listed and cannot be removed via this window. In this 
case, check the documentation that came with the specific program. 
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2.8.1 Updating Antivirus Software 

There are thousands of known viruses, and more appear all the time. Installing antivirus 
software is the only way to protect your data, software, and hardware. Regular updates are 
necessary to ensure protection. 

Your computer dealer can advise you regarding purchasing antivirus software. 
 

 
Before installing any software from unlicensed sources, scan for viruses. Regularly 
backup your data to safeguard against loss if your notebook is infected. 

2.8.2 Backing Up Files 

Regularly backing up your files will protect you from losing data from accidental file 
deletion, viruses or hard drive failure.  

Programs can be reinstalled, unless you have backed up your work, you will lose your data 
files. 

The most convenient way to back up your files is to a CD-RW drive. For smaller files, you 
can use a floppy disk. 

2.8.3 Finding Files 

Right click on Start > Search. 

In the search window, type either All or part of the file name or A word or phrase in the 
file. 

Specify where you want the system to look by specifying a drive or folder in the Look in 
pull-down menu. 
 

 
Windows will search the entire hard drive (or drive C partition) if the default setting 
of C: is unchanged. 

 

Click Search to begin searching. 

Files found that match your search criteria are listed in the Search Results window. 

2.8.4 Copying a File on the Hard Drive 

From the Desktop, select My Computer. 

Locate the file you want to copy, and click the file to select it. 

Under File and Folder Tasks > Copy this file. 

In the Copy Items window, select the location where you want to copy the file. 

Click Copy. 
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2.8.5 Copying a File to a Floppy Disk 

Insert a floppy disk into the external floppy drive. 

From the Desktop, select My Computer. 

Locate the file you want to copy, and click the file to select it. 

Under File and Folder Tasks > Copy this file > Copy Items > 3½ Floppy (A:). 

Click Copy. 

2.8.6 Moving Files 

 
Never move files that are part of an installed program. Doing so may make the 
program unusable. 

 

From the Desktop, select My Computer. 

Locate the file you want to move, and click the file to select it. 

Click Move this file. 

In the Move Items window, click the location where you want to move the file. 

Click Move. 

2.8.7 Renaming Files 

Use Windows Explorer or My Computer to locate the file you want to rename, and click 
the file to select it. 

Click the File menu and click Rename. 

 
Never change a file's extension (the last three characters after the period). Doing so 
may render the file unusable. 

 

Type the new filename and press Enter. 

2.8.8 Deleting Files 

 
Never delete files that are part of an installed program. Doing so may render the file 
unusable. 

 

Use Windows Explorer or My Computer to locate the file you want to delete, and click 
the file to select it. 

Click the File menu and click Delete. 

Click Yes to send the file to the Recycle Bin. 

If you accidentally delete a file, see 2.8.10 Retrieving Files From the Recycle Bin. 
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2.8.9 Emptying the Recycle Bin 

Files remain in the Recycle Bin and take up space on the hard drive until you empty them 
from the Recycle Bin. 

 
Files deleted from an external drive or from a network are permanently erased. You 
cannot recover them from the Recycle Bin. 

 

Double-click the Recycle Bin icon.  

The Recycle Bin window appears and lists all deleted files, their previous locations, and the 
dates you deleted them. 

Click the File menu, and click Empty Recycle Bin. 

When the confirmation dialog box appears, click Yes to delete all file(s). 

All files disappear from the Recycle Bin and are removed from your notebook. 

2.8.10 Retrieving Files From the Recycle Bin 

Deleted files are moved to the Recycle Bin and remain there until you empty the Recycle 
Bin. If you delete a file in error, you can retrieve it from the Recycle Bin: 

 

Double-click the Recycle Bin                     icon. 

 

The Recycle Bin window will appear, listing all deleted files, their previous locations, and 
the dates you deleted them. 

Select the file you want to retrieve, click the File menu, and then click Restore. 

The file disappears from the Recycle Bin and is moved to its original location. 
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 Adjusting the Volume 
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2.9.1 Inserting Discs 

 
Be careful not to press down on the drive tray when opening or closing it. When the 
drive is not in use, keep the tray closed. 

 
Do not move the computer when playing CDs or DVDs. 

 

To insert a disc, do the following: 

1. Press the eject button on the front of the drive. 

2. Pull the tray out. 

3. With the label side up, place the disc in the center of the tray. 

4. Snap the disc onto the spindle. 

5. Gently push the tray back into the drive. 

If your notebook has a CD-RW/DVD or DVD, you can watch movies. 

For more information on playing CDs or watching movies, click Help on the CD player 
software or DVD player software. 

2.9.2 Adjusting the Volume 

 
If you do not hear anything when playing a CD or DVD, check that the speakers are 
not muted. 

 

Start > All Programs > Accessories > Entertainment > Volume Control. 

In the Volume Control window, click and drag the bar in the Volume Control column and 
slide it up or down to increase or decrease the volume. 

 
Audio Volume Down 

 
Audio Volume Up 

2.9.3 Adjusting the Picture 

If you receive an error message that the current resolution and color depth are using too 
much memory and preventing DVD playback, adjust the display properties: 

Start > Control Panel > Pick a category > Appearance and Themes > Pick a task... > 
Change the screen resolution. 
In the Display Properties window, click and drag the bar in Screen resolution to change 
the setting to 1024 x 768 pixels. 

Click the pull-down menu under Color quality > Medium (16 bit) > OK.
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3.1.1 Turning Your Notebook On 

 
You can configure the computer to start from a specific drive, such as a CD-ROM, 
an external floppy disk, or even an external device. See 8.7 The Boot Menu. 

 

Press the power button  to turn on your notebook. 
 

 
Do not turn off the computer until the operating system has loaded completely. 
Turning the computer off during its initial startup will result in an error the next 
time you start your notebook. 

3.1.2 Turning Your Notebook Off  

Save and close any open files, exit any open programs.  

Click Start >  > Shut Down. 

Your notebook will automatically turn off after the shutdown process is finished. 
 

 
Press the power button to shut down or enter sleep mode. Click Start > Control 
Panel > Power Options > Choose what the power button does. 

3.1.3 Logging Off 

With Microsoft Windows Vista, multiple users have access to a single computer with their 
own personal settings. Using their own password, each user can log on to the computer 
which using their own private profile and settings.  

To log off: 

Save and close any open files, exit any open programs, click Start >  > Log Off. 

To switch users: 

Click Start >  > Switch User. 

Using Fast User Switching, programs executed by previous users remain running in the 
background. This means a possible slower computer response. It may also stop multimedia 
programs, including games and DVD software, from running. 
 

 
Fast User Switching does not work if your notebook is running Windows Vista and 
is a member of a computer domain or if the notebook has less than 128 MB of 
memory. 
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3.1.4 Adding User Accounts 

 
Different account options are available when a computer is running Windows Vista 
operating system and is connected to a domain. 

 

With Windows Vista installed, the system administrator or a user with administrator rights 
can create additional user accounts: 

1. Click Start > Control Panel > User Accounts and Family Safety > User Accounts > 
Manage another account. 

2. When prompted, click Continue. 

3. Click Create a new account. 

4. Enter the name of the new user and choose one of the following options: 

• Standard user: User can install some programs and hardware. 

• Administrator: User can change all computer settings. 

5. Click Create Account. 

3.1.5 Sleep Mode 

To find out how to conserve power using the Sleep Mode, see 7.1 Power Management.  
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3.2 Tips for Using Windows 

 Microsoft Windows Vista Help 

 Windows Desktop 

 Start Button 

 Taskbar 

 Notification Area (System Tray) 

 Recycle Bin 

 Control Panel 

 Computer 
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3.2.1 Microsoft Windows Vista Help 

For Microsoft Windows Vista help, go to Start > Help and Support. The Windows Help 
and Support dialog box opens. 
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3.2.2 Windows Desktop 

 
Depending on your notebook setup and software, your desktop may have different or 
additional shortcuts. See 3.4 Personalizing Your Desktop for more information. 
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3.2.3 Start Button 

The Start button allows easy access to your notebook's programs. 

 
The Start menu is designed to adapt to show the programs you use most frequently. To 
always keep an item on the Start menu, no matter how often it's used, right-click the item 
and click Pin to Start menu. 

 puts the current session into memory and enters a low-power state ready to be resumed. 

   locks this computer 

  provides options for turning off, restarting, switching users, logging off, and placing 
your notebook in power saving modes. 
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3.2.4 Taskbar 

The Start button is on the left and the notification area on the right. Each time you open a 
program, a button for it appears on the taskbar. To move between programs, simply click the 
relevant button. Windows Vista groups multiple instances of the same program on a single 
taskbar button if more space is needed.  

Toolbars can be added to or removed from the taskbar: 

Right-click an empty spot on the taskbar, and select Toolbars > choose the toolbar you 
want to add. 

3.2.5 Notification Area (System Tray) 

The icons in this area allow quick access to programs and computer functions, including the 
clock and printer status. Windows Vista hides icons that are not frequently used. Click < to 
see hidden icons.  

To prevent Windows Vista from hiding icons: 

Right-click an empty spot on the Taskbar > Properties > Notification Area > ensure that 
Hide inactive icons is not checked. 
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3.2.6 Recycle Bin 

When you delete a file, it is moved to the Recycle Bin. Files can be restored from the 
Recycle Bin. 

Emptying the Recycle Bin deletes files permanently. 

3.2.7 Control Panel 

In the Control Panel, you can change how Windows looks and works. 

Click the Start button and then Control Panel. 

There are two interfaces - you can choose either Control Panel Home or Classic View. You 
can switch interfaces in the upper left hand of the Control Panel window. 

Choose the task description you wish to complete, and then choose the task in the next 
window.  
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3.2.8 Computer  

Computer allows you to see the disk drives and other external devices connected to your 
computer. The Computer icon displays on your Desktop. To see the contents of a drive or 
folder, open Computer then double-click the icon of the drive or folder you want to view 
(for example, drive C). 
 

 
You can also use Windows Explorer to see the contents of your notebook and find 
files. To open Windows Explorer, right-click the Start button and click Explore. 
Find the drive or folder that you want to view. To find out more about Computer
and Windows Explorer, see the Windows Help and Support. 
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3.3 Keyboard and Touch Pad 

 Numeric Keypad 

 Keyboard Shortcuts 

 Windows Logo Key Functions 

 Sticky Keys 

 Touch Pad 

 Customizing the Touch Pad 

 Finger Printer 
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3.3.1 Numeric Keypad 

Keypad numbers and symbols are marked in blue on the lower right edge of the keypad 
keys.  

To enable the numeric keypad, press . 

The  indicator will light when the numeric lock is on. 

To disable the numeric keypad, press  again. 

To use the primary function of a dual-function key when the numeric keypad is enabled,  

press  and the desired key.  

3.3.2 Keyboard Shortcuts 

 
Sleep 

 

Wireless/Bluetooth On/Off 

To enable this function, you need to install Wireless Select Switch.

 

Switches Display Mode (LCD > CRT > TV > LCD + CRT 
Simultaneous > LCD+TV Simultaneous). Switches the video image 
to the next display or both displays simultaneously. 

 
Brightness Down 

 
Brightness Up 

 
Mute 

 
Audio Volume Down 

 
Audio Volume Up 

 
Play/Pause 
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Stop 

 
Fast Rewind 

 
Fast Forward 

  Number Lock 

  
Scroll Lock 

 
Caps Lock 

3.3.3 Windows Logo Key Functions 

  
Opens Windows Explorer 

  
Opens the Run dialog box 

  
Opens the Search Results dialog box 

  

Opens the Search Results - Computers dialog box (when 
your notebook is connected to a network) 

  
Opens the System Properties dialog box 

 
To adjust keyboard operation, including character repeat rate, in the Control Panel click 
Hardware and Sound > Keyboard. 
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3.3.4 Sticky Keys 

The Sticky Keys function lets you use the SHIFT, CTRL, ALT, FN keys or the Windows 
logo key (referred to as modifier keys) in conjunction with other keys by pressing one key at 
a time instead of simultaneously. 

To activate Sticky Keys mode, press the Shift key five times and then click YES. 

 
Alternatively, you can click on Start > Control Panel > Ease of Access > Change how 
your keyboard works and check Turn on Sticky Keys before clicking Save. 
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To further customize Sticky Keys, click Set up Sticky Keys in the above dialogue box. The 
following dialogue box will appear. 

 
Click Turn on Sticky Keys to enable the listed shortcuts to activate Sticky Keys mode. 

By checking Lock modifier keys when pressed twice in a row, pressing the SHIFT, 
CTRL, ALT, FN or the Windows logo key twice will 'lock' the key until it is pressed again. 
This allows you to perform multiple commands with these keys in succession without 
having to press the modifier key again each time. 

Check Turn off Sticky Keys when two keys are pressed at once to have Sticky Keys 
automatically disable whenever any two keys are pressed simultaneously. 

If Play a sound when keys are pressed is checked, a tone will be heard each time a 
modifier key is pressed. Different tones are heard when activating and deactivating modifier 
keys. 

Check Display the Sticky Keys icon on the task bar to display the Sticky Keys icon in 
your toolbar whenever the Sticky Keys mode is activated. The icon will change to indicate 
which modifier key, if any, is currently active. 

Click on Save to confirm your changes, Cancel to exit the dialogue box without making any 
changes, or Apply to have your settings take effect without saving. 
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3.3.5 Touch Pad 

The Touch Pad responds to the movements and pressure of your finger, allowing you to 
move the cursor around the screen, in the same way you would with a mouse. 

 
Place your fingers on the keyboard in the normal typing position. 

You can use the Touch Pad by moving either your right or left thumb off the space bar and 
on to the Touch Pad. 

Gently move your thumb across the Touch Pad in the direction you want the cursor to move. 

The Touch Pad buttons have the same function as mouse buttons. Clicking these buttons 
makes selections, drags objects, or performs a variety of other functions depending on the 
software. To select an object, first move the pointer over the object you want to select, and 
then press the left button one time and release it. The functionality of these buttons depends 
on your software. 

Double-clicking is a common technique for selecting objects or launching programs. 

You may also select object or execute applications from icons by double tapping. This is 
similar to double-clicking; instead of pressing the Touch Pad buttons, you tap the Touch Pad 
itself. 

3.3.6 Customizing the Touch Pad 

To adjust Touch Pad settings, use the Mouse Properties window, which you can open by 
clicking Control Panel > Hardware and sound > Mouse. 

Select the desired settings and click Apply. 

Click OK to save the settings and close the window. 
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3.3.7 Finger Printer 

The finger printer lets you log on to your computer instead of inputting passwords from the 
keyboard. 

To raise the recognition success rate, the following illustrations show the correct way to 
swipe your finger over the finger printer. 

 
Align your fingertip with the finger printer as shown in the drawing and swipe. 

 

To reduce the damage to the finger printer and fingerprint recognition problems, follow 
these guidelines when using the finger printer. 

• Do not scratch or poke the finger printer with your nails or any hard or sharp 
objects. 

• Do not press the finger printer strongly. 

• Do not touch the finger printer with a wet finger or any wet objects. Keep finger 
printer surface dry and free of water vapor. 

• Do not touch the finger printer with a soiled finger. Minute foreign particles on a 
soiled or dirty finger may scratch the finger printer. 

• Do not paste stickers or write on the finger printer. 

• Do not touch the sensor with a finger or any object with built-up static 
electricity. 
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3.3.7.1 Delete the Finger Printer Data 
Saved fingerprint data is stored in the non-volatile memory inside the finger printer. 
Fingerprint data are recommended to delete before you hand over the computer the others, 
or dispose of it. 

To delete the fingerprint data, do the following: 

1. Click Start > All Programs > Protector Suite QL > Control. 

2. The Protector Suite Software screen is displayed. 

3. Click Fingerprints > Delete. 

4. Click Settings > Fingerprint Storage Inspector. 

5. The Fingerprint Storage Inspector screen is displayed. If other fingerprint data is still 
displayed on the list. Select all fingerprint data and click remove. 

6. Check whether all fingerprint data was deleted on the Fingerprint Storage Inspector 
screen. 
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3.4 Personalizing Your Desktop 

 Choosing a Wallpaper 

 Choosing a Screen Saver 

 Choosing a Desktop Theme 

 Creating a Shortcut on the Desktop 
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3.4.1 Choosing a Wallpaper 

To make your notebook reflect your style, you can set background colors, patterns, and the 
wallpaper on the desktop. 

Control Panel > Appearance and Personalization > Change desktop background. 

Choose the picture or color you want for your desktop background. 

You can also choose your own images by choosing Browse, and specifying images in a 
directory. 

Under How should the picture be positioned, choose a way for the position of your 
selected image: Fit to screen (scales the image to fit the screen), Tile, or Center (places one 
copy of the image in the center of the screen). 

To accept the settings, click OK to save your settings and close this window. 

3.4.2 Choosing a Screen Saver 

Control Panel > Appearance and Personalization > Change screen saver. 

Select a screen saver from the Screen saver pull-down menu, or click (None) if you prefer 
not to activate a screen saver. 

You can customize your screen saver by choosing Settings. To check your selections, 
choose Preview. 

To accept the settings, click OK and close the Screen Saver Settings window. 

3.4.3 Choosing a Desktop Theme 

Desktop themes change the appearance of your desktop and add sound effects: 

Control Panel > Appearance and Personalization > Change the theme. 

Select a theme from the Theme pull-down menu in the Theme Settings Window, and then 
click OK. 

3.4.4 Creating a Shortcut on the Desktop 

A shortcut is an icon that is placed on the desktop let you quickly access programs, files, 
folders, and drivers. To create a shortcut: 

Open Computer or Windows Explorer, and highlight the file or program you want to 
create a shortcut to. 

Click and hold down the right Touch Pad button, drag the highlighted item to the Windows 
desktop, and then release the right Touch Pad button to display a pop-up menu. 

Click Create Shortcuts Here. 

An icon appears on your desktop - double-click to activate the shortcut. 
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3.5 Display 

 Adjusting the Brightness 

 Using an External Monitor or Television 

 Setting the Display Resolution 
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3.5.1 Adjusting the Brightness 

To conserve power when running your notebook from the battery, set the brightness to the 
lowest comfortable setting using the keyboard shortcuts. 
 

 
Brightness Down 

 
Brightness Up 

3.5.2 Using an External Monitor or Television 

When you start your notebook with an external display device such as an external monitor 
or television attached and turned on, the image may appear on either the display or the 
external device. 

Alternatively, you can press  to switch the video image to the display only, the 
display and the external device simultaneously, or the external device only. 

3.5.3 Setting the Display Resolution 

To view a program at a specific resolution, both the video controller and display must 
support the program and the necessary video drivers must be installed. 

Before changing any of the original display settings, note the original settings for future 
reference. 

Click Start > Control Panel > Appearance and Personalization > Adjust screen 
resolution. 

You can try different settings for screen resolution and color quality. 

If you choose a resolution or color depth that is higher than the display supports, the settings 
will automatically adjust to the closest possible setting. 
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3.6 Networks 
To access a network: 

At the office, you can access a network via the built-in PCI-E LAN.  

For specific information about connecting to the LAN or WAN, consult your systems 
administrator. 

If you are working at home or while traveling, you need a dial-up connection. Ask your 
system administrator for the telephone number of the network. 

To set up the connection, go to Start > Control Panel > Network and Internet > Network 
and Sharing Center. Click Set up a connection or network on the left pane of the 
Network and Sharing Center window. 

Choose a connection option and follow the on-screen instructions to set up your network 
connection. 
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3.7 Managing Programs 

 Running Programs 

 Adding Software 

 Removing Software 
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3.7.1 Running Programs 

Programs are any software that process data - like a word processing program or an email 
program. They require an operating system - like Windows Vista - to run on. 

To run a program, click Start > All Programs. 

Click the program you want to run. 

On the right side of the title bar in the window of any open program there are three icons:  

 
 minimizes the program window. That is, it is removed from the screen, but is still 

running. It will appear as a button on your bottom taskbar. To restore the program window, 
simply click the button. 

 maximizes the window to fill your entire screen. When the window is maximized, the 
button switches to , which will reduce the size of the window when clicked. 

 closes the program or document. 

3.7.2 Adding Software 

To check what software is already installed on your computer, click Start > All Programs. 
If a program is listed in the All Programs menu or the Start menu, the software is already 
installed. 

Before installing software, check the software's technical requirements to ensure that it is 
compatible with your notebook and that there is enough memory and hard drive space for 
installation and operation. 

Temporarily disable your notebook's antivirus software before installing software. See the 
documentation that came with the antivirus software for detailed procedure. 
 

 
Be sure to enable your antivirus software once you have installed any new software.

 

Insert the software installation CD into the CD drive and follow the instructions that came 
with the software to help you respond to the prompts on the screen. 

If the software installation CD does not automatically run, click Start > All Programs > 
Accessories > Run. In the dialogue box, type x:\setup.exe (where x is the letter of your CD 
drive [usually D or E]). Then click OK and follow the prompts on your screen. 
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3.7.3 Removing Software 

 
Once you've begun removing software, do not interrupt the process. To do so may 
result in data loss and corruption of your operating system. 

 

Start > Control Panel > Programs > Uninstall a program. 

Select the program that you want to remove and click the Uninstall or Change button. 
Instructions for removing programs will appear on the screen. 
 

 
Some programs may not be listed and cannot be removed via this window. In this 
case, check the documentation that came with the specific program. 
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 Retrieving Files From the Recycle Bin  
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3.8.1 Updating Antivirus Software 

There are thousands of known viruses, and more appear all the time. Installing antivirus 
software is the only way to protect your data, software and hardware. Regular updates are 
necessary to ensure protection. 

Your computer dealer can advise you regarding purchasing antivirus software. 
 

 
Before installing any software from unlicensed sources, scan for viruses. Regularly 
backup your data to safeguard against loss if your notebook is infected. 

3.8.2 Backing Up Files 

Regularly backing up your files will protect you from losing data from accidental file 
deletion, viruses or hard drive failure.  

Programs can be reinstalled, unless you have backed up your work, you will lose your data 
files. 

The most convenient way to back up your files is to a CD-RW drive. For smaller files, you 
can use a floppy disk. 

3.8.3 Finding Files 

Right click on Start > Search. 

In the search window, type a word or part of a word in the search box. 

As you type, files from a variety locations (drives and folders on your computer) that match 
your text will appear. 

You can click one of the available filter buttons to show only certain kinds of files, such as 
E-mail, Document, Picture, or Music. 

3.8.4 Copying a File on the Hard Drive 

From the Desktop, select Computer. 

Locate the file you want to copy, and click the file to select it. 

Right click the file you want to copy, and then click Copy. 

Open the location where you want to store the copy. 

Right click within the location, and click Paste. 
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3.8.5 Renaming Files 

Use Windows Explorer or Computer to locate the file you want to rename, and click the 
file to select it. 

Click the Organize menu and select Rename. 

 
Never change a file's extension (the last three characters after the period). Doing so 
may render the file unusable. 

 

Type the new filename and press Enter. 

3.8.6 Deleting Files 

 
Never delete files that are part of an installed program. Doing so may render the file 
unusable. 

 

Use Windows Explorer or Computer to locate the file you want to delete, and click the file 
to select it. 

Click the Organize menu and click Delete. 

Click Yes to send the file to the Recycle Bin. 

If you accidentally delete a file, see 3.8.8 Retrieving Files From the Recycle Bin. 

3.8.7 Emptying the Recycle Bin 

Files remain in the Recycle Bin and take up space on the hard drive until you empty them 
from the Recycle Bin. 

 
Files deleted from an external drive or from a network are permanently erased. You 
cannot recover them from the Recycle Bin. 

 

Double-click the Recycle Bin icon.  

The Recycle Bin window appears and lists all deleted files, their previous locations, and the 
dates you deleted them. 

Click the File menu, and click Empty Recycle Bin. 

When the confirmation dialog box appears, click Yes to delete all file(s). 

All files disappear from the Recycle Bin and are removed from your notebook. 
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3.8.8 Retrieving Files From the Recycle Bin 

Deleted files are moved to the Recycle Bin and remain there until you empty the Recycle 
Bin. If you delete a file in error, you can retrieve it from the Recycle Bin: 

Double-click the Recycle Bin    icon. 

 

The Recycle Bin window will appear, listing all deleted files, their previous locations, and 
the dates you deleted them. 

Select the file you want to retrieve, and click Restore this item. 

The file disappears from the Recycle Bin and is moved to its original location. 

You can also recover all the files from the Recycle Bin by clicking Restore all items. 
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 Inserting Discs 

 Adjusting the Volume 

 Adjusting the Picture 
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3.9.1 Inserting Discs 

 
Be careful not to press down on the drive tray when opening or closing it. When the 
drive is not in use, keep the tray closed. 

 
Do not move the computer when playing CDs or DVDs. 

 

To insert a disc, do the following: 

1. Press the eject button on the front of the drive. 

2. Pull the tray out. 

3. With the label side up, place the disc in the center of the tray. 

4. Snap the disc onto the spindle. 

5. Gently push the tray back into the drive. 

If your notebook has a CD-RW/DVD or DVD, you can watch movies. 

For more information on playing CDs or watching movies, click Help on the CD player 
software or DVD player software. 

3.9.2 Adjusting the Volume 

 
If you do not hear anything when playing a CD or DVD, check that the speakers are 
not muted. 

 

Start > All Programs > Accessories > Windows Mobility Center. 

In the Windows Mobility Center window, click and drag the bar in the Volume column 
and slide it left or right to decrease or increase the volume. 

 
Audio Volume Down 

 
Audio Volume Up 

3.9.3 Adjusting the Picture 

If you receive an error message that the current resolution and color depth are using too 
much memory and preventing DVD playback, adjust the display properties: 

Start > Control Panel > Appearance and personalization > Personalization> Display 
Settings. 

In the Display Properties window, click and drag the bar in Resolution section to change 
the setting to 1024 x 768 pixels. 

Click the pull-down menu under Colors, select Medium (16 bit), and click OK.
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4.1 Caring for Your Notebook 

 Cleaning Your Notebook and Keyboard 

 Cleaning the Display 

 Cleaning the Touch Pad 

 Cleaning the CD/DVD Drive 

 Precautions 

 

 
Never spray cleaning products directly onto your notebook's case or display. Only 
use products designed for cleaning computer displays. 
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4.1.1 Cleaning Your Notebook and Keyboard 

1. Shut your notebook down, turn it off and disconnect it from the electrical outlet and any 
external devices, such as a printer. 

2. Remove the battery pack. 

3. Use the brush attachment of your vacuum cleaner to gently remove dust from your 
notebook's openings and keyboard. 

4. Use a slightly moistened soft, lint-free cloth to wipe your notebook and keyboard. Use 
only water or a recommended computer cleaner. 

4.1.2 Cleaning the Display 

1. Shut your notebook down, turn it off and disconnect it from the electrical outlet and any 
external devices, such as a printer. 

2. Remove the battery pack. 

3. Use a slightly moistened soft, lint-free cloth to wipe your notebook's display. Use only 
water or a recommended computer cleaner. 

4.1.3 Cleaning the Touch Pad 

1. Shut your notebook down, turn it off and disconnect from the electrical outlet and any 
external devices, such as a printer. 

2. Remove the battery pack. 

3. Use a slightly moistened soft, lint-free cloth to carefully wipe the Touch Pad, being 
careful not to allow any moisture into the gaps. Use only water or a recommended 
computer cleaner. 

4.1.4 Cleaning the CD/DVD Drive 

 
Never touch the lens. Use only compressed air to clean the lens. 

 

If you experience problems playing CDs or DVDs, including skipping, clean the unlabelled 
side of the disc with a soft, lint-free cloth or using a commercial product. 
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4.1.5 Precautions 

• Do not spill liquids on the keyboard. If liquid is spilt on the keyboard, turn your 
notebook off immediately. Leave off overnight to let it completely dry out 
before using it again. 

• Do not turn off your notebook if a drive light indicates a drive is active. Turning 
off your notebook while it is reading from or writing to a disk may damage the 
disk, the drive, or both. 

• Keep your notebook and disks away from objects that generate strong magnetic 
fields, such as stereo speakers. Information on disks is stored magnetically. 
Placing a magnet too close to a disk can erase important files. 

• Scan all new files for viruses. This precaution is especially important for files 
you receive via email, disk or download from the Internet. You will need a 
special program to scan for viruses. For further information, talk to your 
computer dealer. 

• To ensure HDD function and the integrity of the saved data, please follow the 
instructions below: 

• Protect the notebook from any impact when it is during operation. 

• Do not use your notebook during transportation such as in a car. 

• Do not put your notebook in a car that is directly exposed to the sun. 

• Do not place any heavy objects on the LCD monitor. 

• Use the AC adapter coming with the package instead of other adapters. 
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4.2 Traveling 

 Identifying Your Notebook 

 Packing Your Notebook 

 Setting a Password 

 Travel Tips 

 If Your Notebook is Lost or Stolen 
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4.2.1 Identifying Your Notebook 

Attach a nametag or business card to your notebook, or use a permanent marker or stencil to 
write a unique identifying mark (such as your driver's license number) on the case. 

Create a file on the Desktop called if found. Place information such as your name, address, 
and telephone number in this file. 

Contact your credit card company, and ask if it offers coded identification tags. 

4.2.2 Packing Your Notebook 

Remove any external devices attached to the computer and store them in a safe place. 

Fully charge the main battery and any spare batteries you plan to carry with you. 

Turn off the computer or put the computer into hibernate mode. 

Disconnect the AC adapter. 

Remove any extraneous items, such as paper clips, pens, and paper, from the keyboard and 
then close the display. 

Pack your notebook and accessories in their carry case. 

Avoid packing the computer with items such as shaving cream, colognes, perfumes, or food. 

Protect the computer, the batteries, and the hard drive from hazards such as extreme 
temperatures, dirt, dust, liquids, or overexposure to sunlight. 

Pack the computer so that it does not slide around in the trunk of your car or in an overhead 
storage compartment. 
 

 
When traveling by air, never check in your notebook as baggage. 

 

4.2.3 Setting a Password 

To provide extra protection for your data and documents, it is advisable to set a password. 

As your notebook is booting (starting up), press F2 to view the BIOS Setup Utility. Use the 
right arrow key to highlight Security. 

Use the down arrow key to select: Set Supervisor Password. Press Enter. 

Type your password, press Enter and re-type to confirm. Press Enter. Your changes will be 
saved. Press Enter to continue. 

Use the right arrow key to select Exit, use the down key to select Exit Saving Changes. 
Press Enter and Yes.  Your notebook will now boot as normal. 
 

 
To enable password protection on Boot, use the down key to select Password on 
boot. Press Enter and select Enabled. 
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4.2.4 Travel Tips 

• If you are traveling abroad, carry proof of ownership—or of your right to use the 
computer if it is company-owned—to speed your passage through customs. 
Investigate the customs regulations of the countries you plan to visit and 
consider acquiring an international carnet (also known as a merchandise 
passport) from your government. 

• Ensure that you know which electrical outlets are used in the countries you will 
visit, and prepare the appropriate power adapters. 

• Check with your credit card company for information about the kinds of 
emergency travel assistance it offers to users of portable computers. 

• When traveling by air, ensure that you have a charged battery available in case 
you are asked to turn on the computer. 

• Before you use the computer on an airplane, verify that such usage is permitted. 
Some airlines forbid the use of electronic devices during the flight. All airlines 
forbid the use of electronic devices during takeoff and landing.  

 

 
Never walk your notebook through a metal detector. Send it through an X-ray 
machine, or have it manually inspected. 

 

4.2.5 If Your Notebook is Lost or Stolen 

Call a law enforcement agency to report your notebook lost or stolen. Ask that a case 
number be assigned and write down the number, along with the name, address, and 
telephone number of the law enforcement agency. If possible, obtain the name of the 
investigating officer. 

If the notebook belongs to a company, notify the security office of the firm. 

4-6 



 

 
5  

Chapter 5 

Peripherals 

 

 



5 Peripherals 

5.1 PCI Express Cards 

 PCI Express Card Types 

 Installing a PCI Express Card 

 Removing a PCI Express Card 

 

5-1 



5 Peripherals 
 

5.1.1 PCI Express Card Types 

The New Card slot supports one 54mm type PCI Express Card. It supports both USB 2.0 
and PCI Express technology, which improves bus speed in data transfer and requires less 
power than PC Cards. 
 

 
A PCI Express Card is not a bootable device. 

 

5.1.2 Installing a PCI Express Card 

PCI Express Cards, with hot-plug feature, allow you to install and remove cards when your 
notebook is running. The card will be detected automatically when installed. 

Usually PCI Express Cards have a mark or symbol to show which end to insert into the slot. 
Insert the card according to the orientation symbol, and slide the card into the slot. Check 
the documents that came with your card if the orientation is unclear. 

 
1. Press to release the dummy card from the New Card slot. 

2. Hold the PCI Express card with its orientation symbol pointing into the slot and the 
topside of the card facing up. 

3. Slide the card into the slot until it clicks into the connector. 

4. If you encounter too much resistance, do not force the card. Check the card orientation 
and try again. 
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5.1.3 Removing a PCI Express Card 

 
 

1. Push the card all the way to in to release it.  

2. Pull the card out of the slot. 
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5.2 Adding and Removing SD/MMC/MS Cards 

 
Before removing an SD/MMC/MS card, stop it running from the configuration 
utility on the taskbar. Failure to do so could result in data loss. 

 

Insert the SD/MMC/MS card into the card reader slot.  
 

To remove the SD/MMC/MS card, push it in gently, it ejects automatically. 
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5.3 Memory Modules 
You can add more memory modules to your computer to improve its performance. 

     
To install a memory module: 
1. Make sure the computer is turned off. 

2. Remove the two screws securing the memory module cover. 

3. Lift off the memory module cover. 

4. There are two memory module ports here. The first one is already occupied by your 
computer’s current memory module. Place the new memory module in the second slot, 
matching up the notch along its connector rim with the tooth in the connection slot. 

5. When the module is secured, press down gently until it snaps into place. 
 

 
Depending on how much additional memory you require, you may need to replace 
the original memory module. 

 

To remove a memory module: 
1. Make sure the computer is turned off. 

2. Remove the two screws securing the memory module cover. 

3. Lift off the memory module cover. 

4. Pop out the two silver latches holding the memory module into place. The module pops 
up. 

5. Grasp the outer edges of the memory module with thumb and forefinger, and then 
gently remove it. 
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6.1.1 Managing Your Notebook’s Power 

 
See 6.2 Battery for more information on getting the best performance from battery 
packs. 

 
Use your notebook connected to an electrical outlet as often as possible as battery 
life expectancy is affected by the number of times it is charged. 

 

Your computer comes with built-in power management. You can configure it, through the 
Power Options program in the Control Panel, to sleep, hibernate, and wake according to 
specific situations. 

When leaving your notebook unattended for long periods, place it in standby or hibernate 
mode. You can exit either power management mode by pressing the power button. 

6.1.2 Power Management Modes 

6.1.2.1 Standby Mode 
This mode conserves power by switching off the hard drive and display after a preset period 
of inactivity (a time-out). When standby mode is exited, your notebook will return to the 
same operating state it was before entering standby. 
 

 
If your notebook loses power from both the electrical outlet and the battery while in 
standby mode, data may be lost. 

 

To enter standby mode in Windows XP:  

Start > Turn off computer > Stand By. Or  

Set your notebook to enter Standby mode: 

• When you close the lid of your notebook 

• When you press the power button 

• When you press the sleep hot key 

The settings can be accessed via the Advanced tab in Power Options Properties (Start > 
Control Panel > Pick a category > Performance and Maintenance > Power Options). 
 

To exit standby mode, press the power button. You cannot exit standby mode by pressing a 
key or the Touch Pad. For more information on standby mode, see 2.1 Turning Your 
Notebook On and Off. 
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6.1.2.2 Hibernate Mode 
In Hibernate mode, system data is copied to the hard drive, and your notebook is completely 
shut down to save power. When exiting Hibernate mode, your notebook returns to the same 
operating state it was in before entering Hibernate mode. 

Hibernate mode can be enabled/disabled in the Power Options Properties window. 

If enabled, your notebook will enter Hibernate mode if the battery charge level becomes 
critically low. 

Depending on how you set the Power Management Options on the Advanced tab in the 
Power Options Properties window, use one of the following methods to enter hibernate 
mode: 

• When you close the lid of your notebook 

• When you press the power button 

• When you press the sleep hot key 

• Start > Turn Off Computer > Hibernate (if the Hibernate option does not 
show, press Shift, and the Standby option will switch to Hibernate). 

If the Hibernate option is not available for these methods, Hibernate mode has not been 
enabled. Check the Enable hibernation box on the Hibernate tab of the Power Options 
Properties window and click Apply to enable Hibernation. 

 

 
If your PC Cards do not operate correctly after exiting Hibernate mode, remove 
and reinsert the card or restart your notebook. 

 

To exit Hibernate mode, press the power button. You cannot exit Hibernate mode by 
pressing a key or the Touch Pad. For more information on hibernate mode, see 2.1 Turning 
Your Notebook On and Off. 
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6.1.3 Power Options Properties 

To access the Windows Power Options Properties window: 

Start > Control Panel > Pick a category > Performance and Maintenance > Power 
Options 

6.1.3.1 Power Schemes Tab 
The Power Schemes pull-down menu in the Power Options Properties displays the selected 
preset power scheme. 
 

 
To maximize battery power, use the Portable/Laptop power scheme. 

 

In Windows XP the processor's performance level depends on the power scheme you select. 
You do not need to make any further adjustments to set the performance level. Each preset 
power scheme has different time-out settings for entering standby mode, hibernate mode, 
turning off the display, and turning off the hard drive. For more information on power 
management options, see the Help and Support Center. 

6.1.3.2 Alarms Tab 
 

 
Enable audible alarms by clicking each Alarm Action button and selecting Sound 
alarm. 

 

The Low battery alarm and Critical battery alarm settings alert you when the battery charge 
falls below a certain percentage.  

When you receive your notebook, the Low battery alarm and Critical battery alarm check 
boxes are selected. See 6.2 Battery for more information on low-battery warnings. 

6.1.3.3 Power Meter Tab 
Displays the current power source, battery status, and charge amount. 
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6.1.3.4 Advanced Tab 
With the Advanced tab you can: 

 Set power icon and standby mode password options. 

 Depending on your operating system, program the following functions by clicking an 
option from the corresponding pull-down menu, and then clicking OK. 

Set the computer to Stand by / Hibernate / Do nothing when you close the 
laptop lid 

Set the computer to Ask me what to do / Stand by / Hibernate / Shut down / 
Do nothing when you press the power button. 

Set the computer to Ask me what to do / Stand by / Hibernate / Shut down / 
Do nothing when you press the sleep hot key. 

6.1.3.5 Hibernate Tab 
The Hibernate tab lets you enable hibernate mode by clicking the Enable hibernation 
check box. 
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6.1.4  SpeedStep 

Your notebook is equipped with SpeedStep technology to better manage power 
consumption. It changes the processor speed to find the best balance between your 
computing performance and power consumption needs. Higher speeds enjoy better 
performance, while slower speeds conserve more power. 

 

In Windows XP, the processor's performance level depends on the Power Scheme you select 
(see 6.1.3 Power Options Properties). You do not need to make any further adjustments to 
set the performance level. Each preset power scheme has different time-out settings for 
entering standby mode, hibernate mode, turning off the display, and turning off the hard 
drive.  

 

For example, the Portable/Laptop mode automatically changes SpeedStep modes 
depending on if you are running the computer on AC power or batteries in order to prolong 
battery usage while still providing optimal performance.  

You can also individually alter and save each of these settings and schemes if desired. 

 
Windows XP automatically chooses the SpeedStep mode to find the most appropriate speed 
for your processor according to the Power Scheme you choose and your current system 
demands. 
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6.2 Battery 
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6.2.1 Battery Performance 

The performance of the battery can vary, depending on operating conditions. Your battery 
may last less time if you are running power-intensive programs, playing CDs or DVDs, or 
have high display-brightness settings. 

The Power Management Options can be set to alert you when the battery charge is low. 
 

 
Ensure any battery you use is compatible. Failure to do so may risk fire or 
explosion. For more details on purchasing compatible batteries, contact your 
notebook retailer. 

 
Batteries should never be disposed of with household waste. Contact your local 
waste disposal or environmental agency for advice on disposing of used lithium-ion 
batteries. 

 
Only use the BATEL80L6 or BATEL80L9 battery pack with this computer. 

 

6.2.2 Checking the Battery Charge 

Battery Status Indicator behavior 

Charging Flashes blue 

Fully Charged Solid blue 

Critical Low Amber > approximately 3 minutes left; system beeps 

6.2.3 Power Meter 

The power meter indicates the remaining battery charge. When your notebook is 
running on battery power, you can check the remaining battery charge, double click 

the icon on the taskbar. For more details, including how to make the icon appear on the 
taskbar if it is not already, see 6.1 Power Management. 
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6.2.4 Low-Battery Warning 

 
After a low-battery warning, save your work immediately, then connect your 
notebook to an electrical outlet. Hibernate mode will begin automatically if the 
battery runs completely out of power. 

 

You will hear the low-battery warning when the battery charge is approximately 90 percent 
depleted. Your notebook will beep once, indicating approximately 10 to 15 minutes of 
battery operating time remain. If you do not connect your notebook to alternative power 
source during that time, there will be a periodic beep. Your notebook will automatically 
enter Hibernate mode if battery charge reaches a critically low level. For more information, 
see 6.1 Power Management. 

6.2.5 Charging the Battery 

 
When connected to an electrical outlet, a completely discharged 6 cell battery 
needs to be charged in 3.5 to 12 hours, and a 9 cell battery in 4.5 to 12 hours 
(depending on whether your notebook is on or off and what programs, if any, are 
running). You can leave the battery in your notebook as long as you like. The 
battery’s internal circuitry prevents the battery from overcharging. 

 

Before using the battery for the first time it must be charged. Connect the computer to an 
electrical outlet and allow the battery to fully charge, indicated by the battery indicator light 
on the front panel of the notebook. 
 

 
Once a battery pack is fully charged for the first time, use your notebook on battery 
power until the battery discharges completely. This will extend battery life, and 
helps ensure accurate monitoring of battery capacity. 

 

If necessary, the battery will be charged whenever your notebook is connected to an 
electrical outlet. 

The battery will not be charged if it or your notebook is too hot, either from use or being in 
a hot environment. If this occurs, the battery indicator will light amber. Disconnect your 
notebook from any electrical outlet, and allow it and the battery to cool to room temperature. 
You can then reconnect your notebook to the electrical outlet and charge the battery. The 
battery indicator will also light amber if the battery is bad and needs replacing. 

6.2.6 Removing the Battery 

Before removing the battery, ensure your notebook is turned off. 

1. Move the battery lock switch to the right (Unlock position). 

2. Slide and hold the battery release latch. 

3. Remove the battery. 
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6.2.7 Installing a Battery 

1. Slide the battery into the bay. 

2. Press it into place gently but firmly until the latch locks it into place. 

3. Slide the battery lock switch back to the locked position. 

6.2.8 Storing a Battery 

If storing your notebook for an extended period of time, remove the battery. Fully charge the 
battery before using your notebook again. 

6.2.9 Working With Extra Battery Packs 

If you spend a lot of time traveling, working without connecting your notebook to an 
electrical outlet, it may be a good idea to carry additional battery packs so you can quickly 
replace a discharged battery and continue working. 

6.2.10 Maximizing Battery Life 

A battery can be recharged many times, but over time it will lose its ability to hold a charge. 
To maximize battery life: 

• If you are not using your notebook for a long period, remove the battery. 

• If you have a spare battery pack, alternate the batteries. 

• Ensure your notebook is off when replacing the battery. 

• Store spare battery packs in a cool, dry place, out of direct sunlight. 
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7.2 Managing Your Notebook’s Power 

 
See 7.3 Battery for more information on getting the best performance from battery 
packs. 

 
Use your notebook connected to an electrical outlet as often as possible as battery 
life expectancy is affected by the number of times it is charged. 

 

Your computer comes with built-in power management. You can configure it, through the 
Power Options program in the Control Panel, to sleep, hibernate, and wake according to 
specific situations. 

The Advanced settings can be accessed via Start > Control Panel > System and 
Maintenance > Power Options. 

On the Select a power plan page, click Change plan setting under the plan that you want 
to change. 

Click Change advanced power settings. Expand the Power buttons and lid category to 
configure the settings. 

When leaving your notebook unattended for long periods, place it in standby or hibernate 
mode. You can exit either power management mode by pressing the power button. 

7.2.1 Power Management Modes 

7.2.1.1 Sleep Mode 
This mode conserves power by switching off the hard drive and display after a preset period 
of inactivity (a time-out). When sleep mode is exited, your notebook will return to the same 
operating state it was before entering sleep. 
 

 
If your notebook loses power from both the electrical outlet and the battery while in 
sleep mode, data may be lost. 

 

To enter sleep mode in Windows Vista: 

Start >  > Sleep. Or 

Set your notebook to enter sleep mode: 

• When you close the lid of your notebook 

• When you press the power button 

• When you press the start menu power button 

The settings can be accessed via Power Options: Advanced settings window. See 7.2 
Managing Your Notebook’s Power. 

To exit sleep mode, press the power button. You cannot exit sleep mode by pressing a key or 
touching the Touch Pad. For more information on sleep mode, see 3.1 Turning Your 
Notebook On and Off. 
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7.2.1.2 Hibernate Mode 
In Hibernate mode, power is conserved by system data being copied to the hard drive, and 
your notebook is completely shut down. When Hibernate mode is exited, your notebook 
will return to the same operating state it was in before entering Hibernate mode. 

Hibernate mode can be enabled/disabled in the Power Options window. 

If enabled, your notebook will go into Hibernate mode if the battery charge level becomes 
critically low. 

Depending on how you set the Power Management Options in the Power Options window, 
use one of the following methods to enter hibernate mode: 

• When you close the lid of your notebook 

• When you press the power button 

• When you press the Start menu power button 

• Start >  > Hibernate. 

The settings can be accessed via Power Options: Advanced settings window. See 7.2 
Managing Your Notebook’s Power. 
 

To exit Hibernate mode, press the power button. You cannot exit Hibernate mode by 
pressing a key or the Touch Pad. For more information on Hibernate mode, see 3.1 Turning 
Your Notebook On and Off. 

7.2.2 Power Options Properties 

To access the Windows Power Options window: 

Start > Control Panel > System and Maintenance > Power Options 

7.2.2.1 Select a power plan 
Windows Vista provides three preset power plans, Balanced, Power saver, and High 
performance. Each plan has different time-out settings for turning off the display and 
entering sleep mode. You do not need to make any further adjustments to set the 
performance level.  

To change setting for the plan, click the following three items on the left pane of the Power 
Options window. 

• Choose when to turn off the display 

• Change when the computer sleeps 

• Adjust the display brightness 

After selecting a plan, you can see the percentage of battery charge remaining and active 
power plan by moving the mouse pointer over the battery meter icon on the taskbar. 

For more information on changing advanced power settings, see the Windows Help and 
Support. 
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To maximize battery power, use the Power saver plan. 

 

7.2.2.2 Power buttons and password protection 
Select Require a password on wakeup, Choose what the power buttons does, or Choose 
what closing the lid does from the left pane of the Power Options window. There are two 
main settings in this section: 

• Power button and lid settings 

• Password protection on wakeup 

Depending on your operating system, program the following functions by clicking an 
option from the corresponding pull-down menu in Advanced settings window, and then 
clicking OK to save your settings and close this window. 

For more information on accessing the Advanced settings window, see 7.2 Managing Your 
Notebook’s Power. 

• Set the computer to Do nothing / Sleep / Hibernate / Shutdown when you 
press the power button. 

• Set the computer to Do nothing / Sleep / Hibernate / Shutdown when you 
close the laptop lid 

• Select the password requirement when the computer wakes from sleep. 

7.2.2.3 Create a power plan 
Besides the three preset power plans offered in Windows Vista, you can also customize your 
own power plan. Select Create a power plan on the left pane of the Power Options window 
to begin configuring your power settings. 

7.2.3  SpeedStep 

Your notebook is equipped with SpeedStep technology to better manage power 
consumption. It changes the processor speed to find the best balance between your 
computing performance and power consumption needs. Higher speeds enjoy better 
performance, while slower speeds conserve more power. 

 

In Windows Vista, the processor's performance level depends on the Power Scheme you 
select (see 7.2.2 Power Options Properties). You do not need to make any further 
adjustments to set the performance level. Each preset power scheme has different time-out 
settings for entering sleep mode, hibernate mode, turning off the display, and turning off the 
hard drive. 
 

For example, the Windows Vista automatically changes SpeedStep modes depending on if 
you are running the computer on AC power or batteries in order to prolong battery usage 
while still providing optimal performance.  
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You can also individually alter and save each of these settings and schemes if desired. 
Choose from the following three power plans that best describes the desired relationship 
between power and performance. 

 
Windows Vista automatically chooses the SpeedStep mode to find the most appropriate 
speed for your processor according to the type of plan you choose and your current system 
demands. 
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7.3 Battery 

 Battery Performance 

 Checking the Battery Charge 

 Power Meter 

 Low-Battery Warning 

 Charging the Battery 

 Removing a Battery 

 Installing a Battery 

 Storing a Battery 

 Working With Extra Battery Packs 

 Maximizing Battery Life 
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7.3.1 Battery Performance 

The performance of the battery can vary, depending on operating conditions. Your battery 
may last less time if you are running power-intensive programs, playing CDs or DVDs, or 
have high display-brightness settings. 

The Power Management Options can be set to alert you when the battery charge is low. 
 

 
Ensure any battery you use is compatible. Failure to do so may risk fire or 
explosion. For more details on purchasing compatible batteries, contact your 
notebook retailer. 

 
Batteries should never be disposed of with household waste. Contact your local 
waste disposal or environmental agency for advice on disposing of used lithium-ion 
batteries. 

 
Only use the BATEL80L6 or BATEL80L9 battery pack with this computer. 

 

7.3.2 Checking the Battery Charge 

Battery Status Indicator behavior 

Charging Flashes blue 

Fully Charged Solid blue 

Critical Low Amber > approximately 3 minutes left; system beeps 

7.3.3 Power Meter 

The power meter  indicates the remaining battery charge. When your notebook is running 

on battery power, you can check the remaining battery charge, double click the  icon on 
the taskbar. For more details, including how to make the icon appear on the taskbar if it is 
not already, see 7.1 Power Management. 
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7.3.4 Low-Battery Warning 

 
After a low-battery warning, save your work immediately, then connect your 
notebook to an electrical outlet. Hibernate mode will begin automatically if the 
battery runs completely out of power. 

 

You will hear the low-battery warning when the battery charge is approximately 90 percent 
depleted. Your notebook will beep once, indicating approximately 10 to 15 minutes of 
battery operating time remain. If you do not connect your notebook to alternative power 
source during that time, there will be a periodic beep. Your notebook will automatically 
enter Hibernate mode if battery charge reaches a critically low level. For more information, 
see 7.1 Power Management. 

7.3.5 Charging the Battery 

 
When connected to an electrical outlet, a completely discharged 6 cell battery 
needs to be charged in 3.5 to 12 hours, and a 9 cell battery in 4.5 to 12 hours 
(depending on whether your notebook is on or off and what programs, if any, are 
running). You can leave the battery in your notebook as long as you like. The 
battery’s internal circuitry prevents the battery from overcharging. 

 

Before using the battery for the first time it must be charged. Connect the computer to an 
electrical outlet and allow the battery to fully charge, indicated by the battery indicator light 
on the front panel of the notebook. 
 

 
Once a battery pack is fully charged for the first time, use your notebook on battery 
power until the battery discharges completely. This will extend battery life, and 
helps ensure accurate monitoring of battery capacity. 

 

If necessary, the battery will be charged whenever your notebook is connected to an 
electrical outlet. 

The battery will not be charged if it or your notebook is too hot, either from use or being in 
a hot environment. If this occurs, the battery indicator will light amber. Disconnect your 
notebook from any electrical outlet, and allow it and the battery to cool to room temperature. 
You can then reconnect your notebook to the electrical outlet and charge the battery. The 
battery indicator will also light amber if the battery is bad and needs replacing. 

7.3.6 Removing the Battery 

Before removing the battery, ensure your notebook is turned off. 

1. Move the battery lock switch to the right (Unlock position). 

2. Slide and hold the battery release latch. 

3. Remove the battery. 
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7.3.7 Installing a Battery 

1. Slide the battery into the bay. 

2. Press it into place gently but firmly until the latch locks it into place. 

3. Slide the battery lock switch back to the locked position. 

7.3.8 Storing a Battery 

If storing your notebook for an extended period of time, remove the battery. Fully charge the 
battery before using your notebook again. 

7.3.9 Working With Extra Battery Packs 

If you spend a lot of time traveling, working without connecting your notebook to an 
electrical outlet, it may be a good idea to carry additional battery packs so you can quickly 
replace a discharged battery and continue working. 

7.3.10 Maximizing Battery Life 

A battery can be recharged many times, but over time it will lose its ability to hold a charge. 
To maximize battery life: 

• If you are not using your notebook for a long period, remove the battery. 

• If you have a spare battery pack, alternate the batteries. 

• Ensure your notebook is off when replacing the battery. 

• Store spare battery packs in a cool, dry place, out of direct sunlight. 
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8 The BIOS Setup Program 

8.1 Introduction 
The BIOS (Basic Input and Output System) Setup program is a menu driven utility that 
enables you to make changes to the system configuration and tailor the operation of your 
notebook to your individual work needs. A ROM-based configuration utility displays the 
system's configuration status and provides you with a tool to set system parameters. These 
parameters are stored in nonvolatile battery backed-up CMOS RAM, which saves this 
information even when the power is turned off. When the computer is turned back on, the 
system is configured with the values found in CMOS. Via easy-to-use menus, you can 
configure such items as: 

 Hard drives, diskette drives and peripherals 

 Video display options 

 Password protection from unauthorized use 

 Boot devices 

The settings made in the Setup program intimately affect how the notebook performs. It is 
important, therefore, to first understand all the available options, and second, to make 
settings appropriate for the way you use the notebook. This chapter guides you through the 
Setup program by providing clear explanations for all Setup options. 

A standard configuration has already been set in the Setup program by the factory 
technicians. However, eventually you may want to customize your system to suit your own 
performance needs. It is recommended that you read this chapter and become familiar with 
the configurations that can be made in the BIOS. 

The next section explains how to move around in the Setup program, as well as how to 
specify and save your new settings. A brief discussion of the optional settings among the 
different submenus follows. 

8-1 



8 The BIOS Setup Program 

8.2 Navigating through the BIOS Setup Program 

 Accessing the BIOS Setup Program 

 Launching Submenus 

 Saving Changes and Exiting the Setup 
Program 

 

 
The Setup program has been designed to make it as easy to use as possible. It is a menu 
driven program, which means you can scroll through the various directories and make your 
selections among the various predetermined choices. If you accidentally configure a setting, 
use the BIOS hot keys to return to the previous value. The hot keys are discussed in more 
detail later in this chapter. 

When turning on the notebook for the first time you may be prompted to run the BIOS Setup 
program. A warning message may appear on the screen if the hardware configuration is 
changed or the POST fails. This message will inform you of any errors or invalid settings 
and prompt you to run the Setup program to correct the problem. 

Even if you are not prompted by a message instructing you to use the Setup program, at 
some time in the future you may want to change the configuration of your computer. For 
example, you may want to make changes to the display option settings or enable the 
notebook's password function for security purposes. It will then be necessary to reconfigure 
your system using the Setup program so that the computer can recognize these changes. 

The list below gives a few examples of reasons why you may want or need to run the BIOS 
Setup program. 

 You have set up the computer for the first time and you got a message stating that you 
should run the BIOS Setup program. 

 You want to redefine the communication ports to prevent any conflicts. 

 You want to change the password or make other changes to the security setup. 
 

 The few examples listed above are by no means complete.  
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8.2.1 Accessing the BIOS Setup Program 

To access the BIOS Setup program, press the [F2] key as soon as the computer starts upTthe 
Phoenix BIOS screen displays. 
 

Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

System Time: [19:34:35] 

System Date: [01/01/2005] 

<Tab>, <Shift-Tab>, or 
<Enter> selects field. 

   

Hard Disk: Hard Disk Model Name  

   

Quiet Boot: [Enabled]  

   

System Memory: 640 KB  

Extended Memory: 1022 MB  

   

BIOS Version: XXXXX  

   

Language: [English (US)]  

 

 

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

The Menu Bar 
The top of the Setup screen has a menu bar with the following selections: 

 
Main Allows the user to configure standard IBM PC AT system parameters. 

Advanced Allows the user to configure advanced system settings. 

Security Allows the user to configure security system settings. 

TPM State Allows the user to configure TPM settings. 

Boot Allows the user to specify the order in which the notebook is to check 
for a device to boot the system. 

Exit Allows the user to save CMOS setting and exit the Setup program. 
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To move between menu bar items, use the [◄] and [►] arrow keys until the desired item is 
highlighted. For example, if you want to move from the Main menu to the Advanced menu, 
press the right arrow key [►] once. 

Item Specific Help 
To the right of the Setup screen, you will notice an item specific help bar. For each item that 
you select on the menu, the bar informs of its specific function as well as the hot keys related 
to that item and/or submenu. 

8.2.2 Launching Submenus 

A submenu contains additional options for a field parameter. To call up a submenu, simply 
move the highlight to the desired field and press the [Enter] key. The submenu opens. 

If you are a first time user or are not familiar with BIOS Setup program, it is highly 
recommended that you take a few minutes to familiarize yourself with each of the submenus 
and their corresponding functions. If you accidentally make unwanted changes to the 
current configuration, go to the Exit menu and select Discard Changes. 

8.2.3 Saving Changes and Exiting the Setup Program 

Refer to the Exit Menu section of this chapter for detailed information on saving changes 
and exiting the Setup program. 
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8.3 The Main Menu 
When the Setup program is accessed, the Information screen appears. It displays the 
following pieces of information regarding your current system: 
 

Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

System Time: [19:34:35] 

System Date: [01/01/2005] 

  

<Tab>, <Shift-Tab>, or 
<Enter> selects field. 

Hard Disk: Hard Disk Model Name  

   

Quiet Boot: [Enabled]  

   

System Memory: 640 KB  

Extended Memory: 1022 MB  

   

BIOS Version: XXXXX  

   

Language: [English (US)]  

 

 

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

System Time and System Date 
The hour is displayed with 24-hour format. The values set in these two fields 
take effect immediately. 

Hard Disk 
The hard disk information is displayed with the manufacturer and model name. 

Quiet Boot 

Enabled: Customer logo is displayed; Summary screen is disabled. 

Disabled: Customer logo is not displayed; Summary screen is enabled. 

System Memory 
This field reports the memory size of system base memory.  The size is fixed to 
640KB. 
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Extended Memory 
This field reports the memory size of the extended memory with an integer in 
the system, but 32Bit SMI will occupy 1 MB and UMA frame buffer (Integrated 
VGA uses only). 

Extended Memory size = Total memory size – 1 MB – 1 MB – UMA frame 
buffer 

BIOS Version 
 This field displays current version of the BIOS. 

Language 
Currently only English is supported. 
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8.4 The Advanced Menu 
Selecting Advanced on the menu bar displays the Advanced Menu. Each field on this menu 
is covered below. 

Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

   Item Specific Help 

AHCI Configuration: [Enabled] 

Total Graphics Memory: 512 MB 

Legacy USB Support: [Enabled] 

Enhanced AHCI: 
WinXP-SP1+IAA driver 
supports AHCI mode. 

   

   

   

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

AHCI (Advanced Host Configuration Interface) Configuration 
Disabled: Disables the AHCI mode. 

Enabled: Enables the AHCI mode. 

Total Graphics Memory 
This field displays the total onboard graphics memory. 

Legacy USB Support 
Disabled: Disables the legacy USB support. 

Enabled: Enables the legacy USB support. 
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8.5 The Security Menu 
The notebook's advanced security system allows you to set a password to prevent 
unauthorized access to system resources, data, and the BIOS Setup program. This section 
covers each Security parameter. Selecting Security from the menu bar displays the Security 
menu. 
 

A Note about Passwords 
The BIOS Setup program allows you to specify passwords in the Security menu. The 
passwords control access to the BIOS and certain Security menu options during system 
startup.  

Passwords are not case sensitive. A password can be entered using either upper or lower 
case letters; it makes no difference. When you choose your password, it should be 
composed of alphanumeric characters (a-z, 0-9) and be eight characters in length. 

NOTE: The supervisor password must be set before the user password can be set.  
 

Set Supervisor Password… / Set User Password… 
Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

Supervisor Password Is: Clear 

User Password Is: Clear 

  

Set Supervisor Password: [Enter] 

Supervisor password 
controls access to the setup 
utility. 

Set User Password: [Enter]  

   

Password on boot: [Enabled]  

   

Built-in HDD1 Status Clear  

   

Built-in HDD1 Password Select [User Only]  

   Set HDD User Password [Enter]  

   

Trusted Platform Support(*) [Disabled]  

 

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

These fields allow you to set the System Password. The System Password allows full access 
to the BIOS Setup menus. To set the Supervisor password, highlight this field and press 
[Enter].  
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Type the password and press the [Enter] key. You can type up to eight alphanumeric 
characters. Symbols are ignored.  

To confirm the password, type the password again and press the [Enter] key.  
 

Supervisor Password Is / User Password Is 
This field displays if the Supervisor/User Passwords is set. 

 Set  System Password is set. 

 Clear      System Password is not set. 
 

Set Supervisor Password / Set User Password  
Enter this field always shows the message. 

While this field is highlighted, press [Enter]. The following message is shown: 
 

Set Supervisor Password: 

                Enter New Password      [                           ] 

           Confirm New Password      [                           ] 

If there is an existing password then setup will prompt with the following window instead 
and the current password will be required to be entered at first: 
 

Set Supervisor Password: 

           Enter Current Password      [                           ] 

                Enter New Password      [                           ] 

           Confirm New Password      [                           ] 

User can type password in field of Enter New Password, and re-enter password in field of 
Confirm New Password for verification. 

If verification OK: 
Setup Notice  

Changes have been saved. 

[Continue] 

The supervisor password is saved after pressing [Enter]. 

If verification fails: 
Setup Warning 

Passwords do not match. 

Re-enter password. 

[Continue] 

The formats of the password are as follows: 

Length:  No more than eight characters. 

Characters: Alphanumeric keys only. The shift status, Ctrl, Shift, Alt, and capitals, are 
ignored. 
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Password on boot 
If password on boot is required, the password must be set otherwise it cannot be enabled. 
Enable this field to have setup prompt for the password when the computer boots. 

Built-in HDD1 Status 
Set  HDD Password is set. 

Clear  HDD Password is not set. 

Built-in HDD1 Password Select 
User Only  For normal user entering HDD password. 

User+Master Master password must be set first before user password can be 
configured. 

Set HDD User Password / Set HDD Master Password 
Enter this field always shows the message. 

While this field is highlighted, press [Enter]. The following message is shown: 
 

Set HDD Master Password 

                Enter New Password      [                           ] 

           Confirm New Password      [                           ] 

If there is an existing password then setup will prompt with the following window instead 
and the current password will be required to be entered at first: 
 

Set HDD Master Password 

           Enter Current Password      [                           ] 

                Enter New Password      [                           ] 

           Confirm New Password      [                           ] 

User can type password in field of Enter New Password, and re-enter password in field of 
Confirm New Password for verification. 

If verification OK: 
Setup Notice  

Changes have been saved. 

[Continue] 

The HDD password is saved after pressing [Enter]. 

If verification fails: 
Setup Warning 

Passwords do not match. 

Re-enter password. 

[Continue] 
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If password on boot is required, the password must be set otherwise it cannot be enabled. 

The formats of the password are as follows: 

Length: No more than 8 characters. 

Characters:  Alphanumeric keys only. The shift status, Ctrl, Shift, Alt, and Capital, are 
ignored. 

Trusted Platform Support (*) 
This item will show up if Trusted Platform Module (TPM) exists within the system. 

Disabled: Disables TPM support. 

Enabled:     Enables TPM support. 
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8.6 The TPM State Menu 
This menu allows the user to understand current TPM state and change the TPM state. 

The TPM state menu will show up if TPM exists within the system and Trusted Platform 
Support item is enabled in “Security Menu”. 
 

Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

Security Chip State: Enable and Deactivated 

  

Change TPM State [No Change] 

  

  

  

  

 

   

   

   

   

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

Security Chip State 
    This field displays the current TPM state. 

Change TPM State 
    No Change     Do not change the TPM settings. 

Enable & Activate  Enable chip encrypted data and user from taking 
ownership. 

Disable & Deactivate  Disable security chip prevents encrypted data from 
being used and Deactivated security chip prevents a 
user from taking ownership. 

Clear Clear Security Chip to default state and release 
ownership. 
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8.7 The Boot Menu 
This menu allows the user to decide the order of boot devices to load the operating system.  
Bootable devices include the diskette drive in module bay, the onboard hard disk drive and 
the CD-ROM in module bay. 

Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

HDD  Hard Disk Model name 

CD/DVD CD/DVD Drive Model name 

FDD  

LAN  

  

  

  

Keys used to view or 
configure devices:  
Up and Down arrows 
select a device. 
<F5> and <F6> moves the 
device up or down. 
<Shift + 1> enables or 
disables a device. 

   

   

   

   

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
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8.8 The Exit Menu 
Phoenix TrustedCore(tm) Setup Utility 

Main          Advanced          Security          TPM State(*)           Boot          Exit 

  Item Specific Help 

Exit Saving Changes   

Exit Discarding Changes     

Load Setup Defaults    

   

    

    

   

   

   

   

   

   

   

F1     Help           ↑↓   Select Item          F5/F6    Change Values             F9     Setup Defaults 

Esc   Exit            ←→ Select Menu        Enter Select 4 Sub-Menu        F10   Save and Exit 
 

Exit Saving Changes 
Allows the user to save changes to CMOS and reboot system. The following message 
prompts the user to confirm after pressing [Enter] on the item. 
 

Setup Confirmation 
Save configuration changes and exit now? 

[Yes]        [No] 

Yes: Exit SETUP and reboot 

No: Go back to previous screen 

Exit Discarding Changes  
Allows the user to exit Setup without saving changes to CMOS. The following message 
prompts the user to confirm after pressing [Enter] on the item. 
 

Setup Warning 
Configuration has not been saved! 

Save before exiting?  
[Yes]        [No] 
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Load Setup Defaults 
Allows the user loads default values in CMOS Setup. The following message prompts the 
user to confirm after pressing [Enter] on this item. 
 

Setup Confirmation 
Load default configuration now? 

[Yes]        [No] 
 

Select Yes to confirm or No to abort. You will then return to the setup screen. 
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